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Introduction
-Please be sure to read and understand Precautions and Introductions in CX-One Setup Manual (W463-E1),

CX-Programmer Operation Manual(W446-E1) and CX-Integrator Operation Manual (W464-E1) before using the
product.

- This Guide describes the basic operation procedure of CX-Programmer. Refer to the Help or the Operation Manual
of the PDF file for detailed descriptions.

- To read the PDF files, you need Adobe Reader, a free application distributed by Adobe Systems.
- The screen views used in this guide may be different from the actual view, and be subject to change without notice.

- The product names, service hames, function names, and logos described in this guide are trademarks or
registered trademarks of their respective companies.

- The symbols (R) and TM are not marked with trademarks and registered trademarks in this guide respectively
-The product names of the other companies may be abbreviated in this guide.

- Microsoft product screen shots reprinted with permission from Microsoft Corporation.
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1. What is CX-One?

CX-One is an FA Integrated Tool Package that integrates Support Software for OMRON's PLC and other
Components.

To construct an FA System based mainly on PLC, traditionally it was necessary to purchase and install
individual Support Software compatible with each Unit, start the software individually, and then connect
to PLC and individual Components.

Installation of this FA Integrated Tool Package "CX-One" on a personal computer allows integrated
operation from setup of OMRON's CPU Bus Units and Special /0 Units (SIOU) and Components to
network start-up/monitoring and improving efficiency of PLC System start-up.

2. Features of CX-One

@® CX-One allows integrated management of Support Software for OMRON's PLC/Components.
« Installation on only one personal computer allows a user to handle Support Software for OMRON's
products.
o Only one licensing key is required to install all Support Software.
o It allows integrated management of one save location for files created by Support Software.

@ Support Software dedicated to CPU Bus Units and Special /0 Units can be started on the 1/0 Table.

e The appropriate dedicated Support Software can be automatically started by specifying a
registered Unit in the I/O Table (Unit configuration table attached to a PLC). In addition, setup
information such as PLC model can be passed to the dedicated Support Software at start-up,
allowing easier switching between Support Software.

® The following functions are available by the introduction of the ID information file (CPS) for OMRON
Components.
¢ Setup of CPU Bus Units and Special I/0 Units without manual setting and address recognition.
(Parameter and selection item names as well as available range of setup are automatically
displayed)
e CPU Bus Units and Special /0 Units setting on personal computer and data on actual PLC (CPU
Unit ) can be verified online, and unmatched item/readout data is displayed graphically.
¢ Unit configuration is displayed on the I/O Table based on Unit model.
¢ Device type on the network can be checked for its Unit model, allowing exact verification of
network configuration.

What is CPS?

CPS (Component and network Profile Sheet) is definition information of CS/CJ series Unit/Components in CX-One.
It is provided as a CPS file (XML format file).

CX-One recognizes CS/CJ series Unit by information in this CPS file. CPU Bus Units and Special I/O Units setting
is created based on this CPS file.




3. Integrated Simulation

Integrated Simulation Overview:

Integrated Simulation is a function of CX-One that simultaneously tests
interoperability between the ladder program and PT (touch panel) and
checks screen operation on the computer.

Earlier Versions:
Operation checks had to be performed separately on the ladder program and PT (touch
panel) screens. In addition, the program had to be downloaded to the devices.

Using Integrated Simulation:
Provides an interoperability check between the ladder program and
touch panel screens.

@ Operation can be verified before actual devices such as the PLC and PT (touch panel) are
installed and wired, so software quality can be improved in the design stage.

® Time can be saved by eliminating the tasks up to downloading the screen data from the
computer to the PT.

® The operation of both the PLC and PT (touch panel) can be verified simultaneously in the
computer, which greatly reduces the time required for debugging and equipment downtime
during improvements.

Simulation of the PLC — PT (touch panel) system can be started
easily, with one click of an icon.
Ladder program Touch panel screen

=
[ simitor ety Consor ORI
I e o 24 33 | 0 8| 2| D

b M n rr———

sl
] | o D00 A A S— |

o CX-Programmer |
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Linked and simulation started.



Integrated Simulation Procedure

Use the following procedure to execute an integrated simulation of the ladder program and PT
(touch panel) screen. For details, refer to the CX-Designer Operation Manual and CX-
Programmer Operation Manual.

1. Create the screen data in the CX-Designer.

DEMO NS8

s

2. Click the % Icon or select Tools — Integrated Simulation. The PLC-PT Integrated Simulation
Dialog Box will be displayed.

PLG-PT Inteerated Simulation

[ |
File Name | Browse

Select a host to execute using the simulator. and a GX-Proerammer project file. The other
hosts run in normal test mode,

3. Click the Browse Button and select the desired ladder program (CXP) file.

4. Click the Start Button. The PLC-PT Integrated Simulation will start automatically.

5. The test window will be displayed.
The Test Tool Window will list all of the communications addresses being used in the displayed
screen. For example, when “Host SERIAL A” is connected to the CX-Simulator, the CX-
Simulator value is reflected in the SERIAL A communications address. (The values can also be

changed.)
T |
D E M 0 N Sa View)  Options(0)  Tool(T)
Dizplay Type IDecimaI—Signad VI
= i Host Type Address Type/Number Walue LI
A Al =] Al =] all |
VIDES SERIALA  [CHANNEL | D007 a
- SERIALA BO0L Q0o00.00 1]
S SERIALA CGHANMEL | DMO0O00 123
SERIALA BOOL 00oo0.01
SERIALA BOOL Qoo00.0z 1
SERIALA _[BOC 1

| TestTool |

Test Window




4. CX-One Installation Procedure

Before installing the CX-One, you must:

e Terminate all Windows programs

¢ Uninstall previous versions of Support Software (such as CX-Programmer) if already
installed.

o Installation takes about 15 to 45 minutes depending on your personal computer.

e To change/modify/delete CX-One after installation, refer to the PDF manual “CX-One
Setup Manual”, Chapter 2 "Installation and Uninstallation”.

Installing CX-One

In case of the installing procedure by DVD-ROM:

Insert CX-One installation disk (DVD-ROM) into your personal computer's DVD-ROM drive.
[Choose Setup Language] dialog box is displayed. By default the OS language installed on
your personal computer is automatically selected.

Check if the language is appropriate, then click the [OK] button.

Choose Setup Language il

@ Select the language for thiz installation from the choices below.
. i

Englizh [United States]

CliCK [OK] = eveeesnrernennnnnns

Cancel

The CX-One splash screen is displayed and CX-One installation starts.

Uninstall older version of tools such as PLC Tools (PLC System setting and 1/O Table),
CX-Server, and CX-Programmer if they have been installed.

Confirm uninstallation CX-Server is already installed on your computer |
AIWayS CIICk [O K] CH-Pragrammer is alrsady installzd on your computer. An older version of C-Server Ver 2,2.1,25 has been found,
Ta cantinue the installation of CX-Server Yer 2.3.0.13, the older version must be uninstalled,

Do wou wish ko uninstall Cx-Programmer? ‘Would yau like Eo uninstall?

Click [OK] ta start the uninstaller. Click [OF] ta continue or [Cancel] ko abork the installation of CX-0ne,
If you do not want ko uninstall, click [Cancel].
Uninstalling CX-Programmer Uninstalling CX-Server



CX-One setup wizard starts.

Welcome tu the InstallShishd Wizard lv
ne Vi

T Il ofShekd® Wizand vell istall (¢l on youe
compuler. To contruse, chek Nexl

Click [Next] cecccssccsccsccsccssccsccssf

The [License Agreement] dialog box is displayed.
Read the software license agreement carefully. If you agree with all items, select the [l accept

the terms of the license agreement] radio button and click the [Next] button.

C% One_v4 - Installshickd Wizard =l

License Agreement omron
Pleci tna the folowing lesnsn agrenment carnhilly cx_€ n’ e

IMPOATANT

By intaling this pack giee o b ing Licoran
Agy 1F you do ol agee. ple the enciosed software ["Softwarc”] without
[ this pnch. e bt ahiog whes you bt e Sollware.

The wsianky semvce 16t hoth n Sechon ¢ of the Soltware License Agreement and sny
P o o the Saltiaie and £5 revit i bé proviced 1o pois,

gistes 4 o st e th B
Ploase prompty fll in the card and send it to OMADN Carporaion.

=

Select the radio DUttON oo e oo | 7 !aermtietems althe icenie apeenect |
1% do ot scceph the beims of the Ieenze sgreement

Click [Next] 505 5650000000000 0000ATT & i T

The [User information] dialog box is displayed.

=
User itormoation omRron p
Plansn pnbes uens indimation.
‘ :x- ne

Plaain et yoa navme. eompary name, and s number, and thon ek [Mess]

Enter [User], [Company], I
[License] (product serial Corgn.

number of CX-One)
Click [Next] .........................mL‘:‘.tj |

The [Regional Information] dialog box is displayed.

=
Hegional Information QmRoN
— cX-Cne

[ and then

Select the [region] in
which the software was
purchased

CIick[Next] --cc.;--;ooooooooooooooog’,& [ neas | ) coea |

=




The [Installation Folder Selection] dialog box and [Setup Type] dialog box are displayed.

Select an installation ¥ ]
folder, then click [Next] . " 0"& )
elaci tha zatup type ta inct i
-L-ne
Pleace elct 3 et e i By selecting [Custom], you

Select the radio button ceece.

can individually select and
[Complete]

install Support Software.

LA Une wil be matabed

.
L]
] Select which application you want installad. °
u) LX-Une ¥4 - Installshield wizard R x|
Select Features : omRrON
L]

Sebact tha features zatup wil ingtal. 0 cx‘% ne

: bl " Sebectthe features you wani to mtal, and dessle the features you do not want 1o install
Click [Next] ...........................@,(i = |)cma | g e

Agplication sllwese: lo ciralr
and verify programs of

SYSMAL U5/ semos,

i C-garies, and CVM | /CV-zaries
] CiMotionHCT CPLU Units.
| CX-Diive
) LMaborr LT |
|| CF-Process
] Face Hlate Auto Buider bor NS
21 CA-Theno = |

1. HLU of space requred on the L dive
B0.61 GE of tpace availsble on the C diive

Read the message and ﬁQ i 1) oo |
click [Next] = :

The [Choose Destination Location of OMRON FB Library], [Select Program Folder], and
[Ready to Install the Program] dialog boxes are displayed.

i E
Ready to Install the Program omRon
The wizard iz ready to begin installation. cx_ & he

Cick, Instal to bagn the instalation.

I wou want bo reviews or change any of vour installabion seltings. click Deck. Chck Cancel to exit
Ehe wizard.

Click [lnsta"] cco-.-cooc-c’c.oco.oo-onoo.f&‘*‘tii__!mm’_fi> Carced

CX-One installation is starts.

During the installation, the [OMRON USB driver Installation Wizard], [WinPcap Setup Wizard],
and [Direct Ethernet Connection: Network Card Selection] dialog boxes are displayed.
Continue with the installation procedure according to the messages displayed by the
Installation Wizard.

L¥-Une ¥4 - Installshield Wizard

A dialog box (right) is displayed.
Click the [Finish] button to finish
the installation wizard.

InetallS hield Wizard Complate

The InstaliShield \wizard has successiuly installed C<-One.
Reefine o e vz e puogpran, poas i iwstanl pooa
computer.

Installation is complete.

(When it is necessary to restart the
personal computer, a restart
confirmation dialog box appears.)

™ Mo, | will restart my camputes lates,

¥ Create 3 Shorcut to "COne Intraduction Guide Librani” on the Desktop

Hemove any disks lom ther dives. and then cick Finsh ba
complete schup.
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Online Registration

If the personal computer that the software has been installed on has an Internet connection,
you can proceed to online user registration.

After installation has been completed the [Online Registration] dialog box is displayed.

Online Registration

Do you want to register online?

Exit |

™ Da not display thiz dialog again.

If you click the [Register] button, your Web browser connects to “OMRON’s CX-One Web
site”.(*1) (*2)

*1: If you click the [Exit] button to cancel online registration, the [Online Registration] dialog box
is displayed every time the CX-One Support Software is started.

*2: If you do not have an Internet connection, or you do not want to register online, fill out and
send the user registration card that comes with the product.
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Example of PLC System Construction by CX-One

Workflow in This Chapter

This chapter describes an example of PLC System construction from design, online debugging on the actual
machine, and start-up/adjustment on-site as shown below.

CX-Programmer is used for ladder program creation and CPU Bus Units and Special /0 Units (SIOU) setting,
while CX-Designer is used for indicator screen generation. Also, a program simulation Support Software CX-

Simulator is used as a debugging example.

: : ; Setting . .
Starting CX-  Creating Unit Checking 1/0 . . Saving
) - PUB - ;
Programmer  Configuration UCnit;J/SIgSU Assignment eolinop Siineibebag Project
S ——
-
R
S
-
R p——
< -
Design Online Debug of the Machine Start-Up/Adjustment On-Site
-7 [ \
- \
-7 - " \\ “
-7 1 \ \
- ] \ \
. Online ) i
Reading Connection Transferring Program Program Pargrr::zeter
Project to Machine Debug Modification
to PLC Change
System Configuration Unit Name Model Specifications
Power Unit CJ1W-PA202
CX-One CIW.0C211 CJ1W-AD081-V1 CPU Unit CJ1IM-CPU13 640 points, 20K steps
B Unit No.= 21
! DC Input Unit CJ1W-ID211
CJ1W-NCF71 - -
(CILW-MCH71) Transistor Output Unit | CJ1W-OC211
Connection Cable ; —
CSlW-CIN226(2m) Unit No.= 2Hex 4 analog inputs (Each point
Analog Input Unit CJ1W-AD081-V1 selectable from 1~5V, 0~5V,
CJ1W-DRM21 0~10V, -10~10V, 4~20mA)
Unit No.= OHex " K - -
- Position Control Unit CJ1W-NCF71 Maximum control: 16 axis
PLC1 Node Address= 01 Motion Control Unit CJIW-MCH71 Maximum control: 30 axis
CJ Series PLC|CJ1
1 ——— CJIW-SCU41-v1 DeviceNet Master Unit | CJIW-DRM21
o8l 8 Unit No.= 3Hex . -
I % E E Ol 10 ControllerLink Unit CJ1W-CLK21
0 - —
0 EL @] 0 S?]irtlal Communications | ~3qw.scua1-vi
= TN CIIW-CLK21-V1
CJ1W-ID211 Unit No.= 1Hex Servo Driver R88D-WNO1L-ML2
4~ 20mA $§f£| r’?adtfgsss;?sltance NS Series PT NS8-TVOOB-V2 |8 inches TFT

Connection Cable
XW2Z-200T(2m)

Vi

NS Series PT
NS8-TV00B-V2
System Version 6.0 or later

Setting= ON

Sensor

Servo Driver
R88D-WNO1L-ML2

Below is an example of a System that has CJ1M CPU
Unit with basic input/output Unit as well as analog input
Unit and NCF Unit to perform the following functions:

e 4~20mA input from a sensor

» Configure a servo driver connected to the NFC Unit.




Setting
CPU Bus
Units/SIOU

Starting CX- Creating Unit

. Checking 1/10
DeSlgn Programmer Configuration

Assignment

Saving
a Project

Programming Offline Debug

Starting CX-Programmer

From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Programmer] > [CX-
Programmer] to start CX-Programmer. (Or select [All Programs] > [OMRON] > [CX-One] >

Starting CX-Programmer [CX-Programmer] > [CX-Programmer])

e —
T
Dl =@k b e@o AL e Al e L Rl RS EEEE L nins

e T o

Creating a New Project Click this button to create a new CX-Programmer project.

File Wiew FLZ
click U | _ q 0 ;,, = | [
e ez ol
Ej Dedicated Support Software for each Unit can be
started, succeeding communications settings from
CX-Programmer. You will not have to set up
communications using dedicated Support Software
if you set up communications here.
Device Mam General |
’7 ‘ {cpu Typ ‘
_ Devie Typ — ETE— )
Click EI and select eeececclfcsmmrmmrecooseoes ? tings... o o a3 52

PLC model.

W—_[ " Readon

—MNetwork Type ’V [Step] ead Oriy

ITUU"JUS J .‘ Sattmgs | Expansion M
’V Hane E ™| Read Oy

r~ Comment ‘
o = File Memay
o Horg” I Read nly ‘
.
: I .
o4 T\rger / Clock:
.
o = o 1%  Irstalled ‘
-
L2
@ oK I Lancel | Help | Make Dafault
.. .. e
o Left-click o Carcel Hol

Settings. . | . DR
ClickE and select CPU type.

Select a PLC model from the following to use Function Blocks. Click [QK] and
CJ2H, CJ2M, CJ1H-H, CJ1G-H, CJIM, CS1H-H, CS1G-H, determine CPU type.
CP1H, CP1L, CP1L-E 2-2



Starting CX-
Programmer

Design

Double-click [ I/O Table
and Unit Setup]

Right-click

Select [Add Unit]

Click + symbol on
analog 1/O

Setting
CPU Bus
Units/SIOU

Creating Unit
Configuration

Creating Unit Configuration

Start the 1/O Table/Unit setup function.

=] =
E% MewProject
=B NewPLC1[CI1M] Offline

-
Bl

- Memory T

Double-click [ 1/0
Table and Unit Setup].

Checking 1/10
Assignment

Project §

Programming

Offline Debug

Saving

a Project

When you select [Option] > [Consumption(mA)] from the
menu, you can check the width and current consumption

after PLC Unit configuration.

(Width indication is available only for SYSMAC CJ Series,

CP1H Series.)
[_ (O]

T | PLC ID Table - NewPLC1
File Edt Wiew ©Options Help

m ClM-cPuL3
y Inner Board
 [0000] Main Rack
™ 4, [0000] Rack 01

[ oxrvcmrtm ad Widths [€11M-CPULT|

Pack  Fowes Supgiy Lint V0 modse Opton bosd
cumefcme 5] | E= B
s |

| [C)IM-CPULS  [Offine

Right-click Empty Slot, select [Add Unit] and determine CPU type.
Then select [General Purpose Analog I/0O] from Unit selection window.

=] E3

T | PLC ID Table - NewPLC1
File Edit Wew Options Help

Select Unit B

Unit

...... # CM-cPU13
gy Inner Board
. =iy [0000] Main Rack
°e, | i 5 00[0000] Empty Slot
- 5 01 [0000] Ermpty Slot
i 0071 Empky Slok

L
..... ﬂ 04 [0
----- 5 os[oo00]E
----- 5 05 [o000]E

Lnit: Comment O
.
SYSMAC BUIS Master ®
.

- Basic 1/0

- Motion Contraller
‘osition Contraller
ensor

----- 5 07 [0000]E .
..... o oa[oooo]E Uit Sebup . ©
..... o 09[00001E  Save Paganfiers

e e oo oo dmrgs foos0] Rack® © A PFarameters

Start Special Application

L]
[#- Temperature Controller

- Communications Adapter
eneral Purpoze Analog 1/0

Cut |+

Copy Chrl+E

Paste CErlH

Delete Spec

Lnit Manufacturing information
Unit Errar Lag
Hot Swap

Cancel




Design

e
Click ] 4 |...................-........ ,

Click ok | O

Starting CX-
Programmer

Creating Unit
Configuration

Setting
CPU Bus
Units/SIOU

Checking 1/10
Assignment

Select Unit Type.

Select Unit

Uit -
- Basic 140

Communications Adapter

[~ General Purpose Analog /0

- CITW-AD 0414 [Analag Input Unit 4 paintz]

g Inpuit Ll
- CI1W-DADA [Analog Output Unit 4 points]

- CJW-DADBC[Analog Dutput Unit 8 pointe/current)

- CITW-DADEY[Analog Output Unit 8 pointz/voltage]

- CI1w-taD42[dnalog 1/0 Unit Input: 4 points/ Output: 2

- CI1wW/-PDC15(| solated-type Analog [nput Unit]

- CI1W-PT 51 5]lsolated-tppe Themocouple Input Unit)

- CI1W-PT 516[lzolated-tppe Resistance Thermometer [npi

- CITW-PT 551[Thermocouple Input unit]

- G 1w -PT S52[Platinum Resistance Thermocouple nput 1—
[+l Mation Contraller

[+ Position Controller -
4« | »

Spec

Cancel |

Programming

Select Unit and Number.

Add Unit

Unit name:  Analog Input Unit 8 points
Unit types  CITW-ADOSTA
- =]
[ Uit 21 =
input range 0 - 95
Cormment:
Enter Unit number.
Cancel |

Offline Debug

Saving

a Project

2-4



Setting
CPU Bus
Units/SIOU

Starting CX- Creating Unit

. Checking 1/0
DeSIQ n Programmer Configuration

Assignment

Programming Offline Debug S

a Project

The Analog Unit is registered to the I/O Table as shown below.
Set up the next analog Unit's parameter.

T | PLC ID Table - NewPLC1 =] B3
File Edit Yiew Options Help

7 Clim-cPuLs

4, Inner Board

=83 [0000] Main Rack
Double-click the analog | - § 00 [0000] Empty Slot

Unit B

..... alog Input Un 3 JiLini i1, ]

1; L e 4
----- 5§ 04 [0000] Empty Slot
----- 5 05 [0000] Empty Slot
----- 5§ 0 [0000] Empty Slot
----- 5 07 [0000] Empty Slot
----- 5 03 [0000] Empty Slot
----- 5 09 [0000] Empty Slot
[+, [0000] Rack 01

=

The Analog Unit Setup Screen is displayed.

[Cam-cru1a  [Offline 4

Displayed Parameter |£Y] ) ; R )
CPU Bus Units and Special /0 Units Setting
Item Setvalue Unit - .
Inputt Input signal use setting Digable Function
Input2 Input si | i Digahl .y e . .
s i signal s soting—[ieatie Traditionally, initial CPU Bus Unit and Special
Inputd Input signal use setting Digable . . .
Inputs Input sianal use sefing Disable I/O Unit settings were made by referring to
Inputé Input signal use setting Digable .
Input7 Input signal use sefing Disable documentation to calculate DM address from
Inputd Input signal use setting Disahle . . .
nputl Input rangs setting OV the Unit number and entering a hexadecimal
Input2 Input range setting +-10% . .
Inputs Input range seting v number. Now you can set it using the pull-down
Inputd Input range setting +-10% . ,
Inpuis Input range seing OV menu in the CX-Programmer’s 1/0O Table.
Inputé Input range setting +-10% ﬂ . . .
e = Easy setup/transfer/verification operations are
A =l available from the integrated parameter settings
screen as shown below, without recognizing
- .| addresses (this function uses CPS function of
Tiansiefntiapel || TansietPeiotinn | | Compae | Fieset CX-One preVIOUS|y dESCTIbed).
Set Defaults Cancel

Setting CPU Bus Units and Special I/O Units

For example, specify input number designation and range.

Unit paramEter Settlng Displayed Parameter [l parameters = ‘
ltem Unit B | . . .
Input Inpul sigral use seting Enatie Select [Enable] for input No.1 usage designation. |
Input2 Input signal use setting I
Input3 Input signal use setting Disable
Inputd Input signal use setting Disahle -
Inputs Input signal use setting Disahle
Inputd Input signal use setting Disahle
Input? Input signal use setting Disahle
Inputd Input signal use setting [
IS0 I D ST oo | Select [1~5V/4~20mA] for input No.1 range setting. |
Inputz Input range setting -
Input3 Input range sefting -0
Inputd Input range setting +-10Y
Inputs Input range setting +-10Y
InputB Input range setting H-10Y =l
" Help
+| |<DefausDisable =
<Address>'word: 022100, Bit1
<Type>List
= L
TiestelUrittore) | | TisfelPE ol || Comar |
ot su gt -| Click the [OK] button,




Design

Right-click NCF Unit

]

Point [Start Special
Application]

]

Click [Start with
Settings Inherited]

Double-click NCF Unit

—
—

Click il

4

Starting CX-
Programmer

Setting
CPU Bus
Units/SIOU

Creating Unit
Configuration

Checking 1/10
Assignment

Saving a

Programming Offline Debug

Project

NCF Unit and Servo Driver Connected to the NCF Unit Setup

As with Analog Unit registration, register the NCF Unit (CJ1W-NCF71).
The NCF Unit resides within a position control Unit.
Nest, start CX-Motion-NCF using [Start with Settings Inherited].

When opening a stored project file after starting the dedicated tool, select [Start Only].
If [Start with Setting Inherited] is selected, a new project is created.

7 PLCI0 Table - NewPLC1
Fie Edit View Options Help

=] B3

| Untitled - CX-Motion-NCF
Fle Wiew PLC Unit Help

[_[O[x]

- & CIM-CPU13

[+-dg, Inner Board

=4 [0000] Main Rack

7l 00 [0000] Empty Siat
¥ 01 [0000] Empty Slot

Change § Confirm Units
Urit Camment
SYSMAC BUS Master 3

-5l 06 [0000] E1
- 41 07 [0000] E1
7 o8 [ooo0] B
¥ 09 [0000] B
[+l 4ag, [0000] Rack C

Uni Setup
Save Parameters

Load Parameters

—F @7 -
Copy CH+C
Paste CErl
Delete

Urit MauFacturing infermation
Uit Error Lo

gs Inherited

5l 02 [2210] CH1W-ADO81 1 (Analog Input Unit & poinks) (Occupancy ¢ 1{Unik : 21) (Out: 1, In: 9)
= ont ) (Uit : 2

DEE|a@| 6 &
Em‘.
‘ f UrutND.UZ(PusllmnCuntrulUnlt)(CJlW—NCF?l)[Nucummenti>
T ——
L]
.
.
.
.
.
.
.
.
.
.
.
.
L]
.
.
L]
.
.
.

.
Press [F1] to disay help.

=

Hot Siap M-CPULS  [Offline YA
Register a servo driver.
|#&Untitled - CX-Motion-NCF [_10O]

File Wiew PLC Unit Help

NI

# PLC[C Series PLC] OFF
Log m

Double-click NCF Unit.

Displayed with NCF Unit registered.

|8 CI1W-NCF71 Axis Map [ %]

Click “n

Pross [F1] to display help. |
MNew Driver
r Diver name
INew Ciriveer 01
- Serie Select OMRON W series (with
IDMHDN w' 5 eriez with Cormmunication |F 2 I| communications function)
r— Diriver model
=y (PP s ]
!F‘SBD-WNW LMLZ e = Select R88D-WNO1L-ML2.
—Aris Mo,
IAxis o 'l
— Comment
_>l_I

2-6
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Edit NCF Unit parameters.

T =
Double-click NCE Unit Fie Edt Onlne Help o Memon AreaSeting
ouble-clic ni v | B = ; (.- Memoty Area Sett | Ais Dperating Memory Area Designation
il |ﬂ| X| ; |1""| I’"‘lﬁl & Communications & "ea (PLC 1o NE L)
o f - s Selting N
LN SA0ILMLZ) Az 01 =
K It Memery v (N Urit o PLE)
- =
.o J IEEID /
o
.
K CI0) snea CIDN000 ke CIOBT43 P sne: 4000 b w11
HR area: HOOD tg HE1T AR area Zp0 to 4353
. . DM area; DODDDD to 32767
Double-click NCF Unit. | EM :r'eeg'E[EII]I]IJE?tnE'?jZ?E?P:EM Sark Na)
Each area occupies [the largest ks No.~ 2§ words.
4 | e
Dovnibad Upload ' -
Set output relay area to
Initalize: .
e | Cl0100 and input relay
area to ClO500.
Leceecceee Select [Axis 01].
o
Edit Unit Parameters d
o
Select - Unit Parameters S s Selting Asis 01

= Unit Paramgers
Memorpirea Sat | Encoder Type

mmfricationdk |~ spcolute Encader @ Incremental Encoder

Euto Communications Setting

[Communications Setting]eee«.-

o Transter Ey.&e (ms] s ~
. o Origin Search Operation
C| |Ck Communisations Cycle (Multiplier)[3 _IZ
L4 = Reversal Mode 1 ¢ Reversal Mode 2 ¢ Single-direction
. . ooof Communications Reties [1 =
Auto Communications Setting] eeeedecccccccer Orign Search Ditction
C2 Master Connection C2 Master not conmec ™ & Foward " Reversa

B eine e 1 3 i Inteinupt Input Signal Selection 1.0 47 °E wemal Latch 5=

No. of Commurications Retiies: Oto 7 [time]

Transfer Cycle [ms] » Communications Cycle [Wullipier] Diigin Inpu Sigral Selecton  [Prasez ]
<=2 [ms]

4 1 2 \J o
Dowrised | Uplod || Gompae | . —
Intzs Caneel Set axis parameters
for axis 01. S
L]
.

Edit servo parameters.

File Edit Online Help
5| ElsX] s ZlE
=) E Urit 2 Mew NC1[C) CF71

MNo.
ol PnsiA

Setling value

“aEzH

Double-click the servo seeee.. i _
) w1 PRSOE  Qutaut signal selection 1 0000H
driver @[] PRsOF  Output signal selection 2 0100H
=] PS10 Output signal selection 3 0000H
®] PRa1l  Input signal selection 5 6543H
=[] Pna12  OQutput signal reverse ooooH

[JPnS1E  Deviation counter overflow warnin... 100

[1Pn520  Deviation counter overflow level 262144

[1Pn522  Positioning completion range 1 3

[JPn524  Pasitioning completion range 2 3

L F Pn528  Deviation cnumernveanlevel at. 262144 hd
4

.. Download | Upload I Compare: |

. Iniisize Cl o D cemcel

Set servo parameters for axis 01 as shown below.
Pn50A(input signal selection 1): 2881 )
Pn50B(input signal selection 2): 8883 Click
Pn511(input signal selection 5): 6541

Save the project Refer to Page 2-13 “Saving Project” for details.
2-7
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Using the MCH Unit
When using the MCH Unit (CJ1W-MCH71) instead of the NCF Unit, use the following settings.
As with Analog Unit, register the MC Unit to the 1/O table.
The MCH resides within the Motion Controller.
Then start CX-Motion-MCH using [Start with Settings Inherited].
When opening a stored project file after starting the dedicated tool, select [Start Only].
If [Start with Setting Inherited] is selected, a new project is created.
Right-click MCH Unit -
-~ CIM-CPUL3
|:j £ oot
-5 00 [0000] Empty Slot
5 01[0000] Empty Slot
H o r. (Occupancy ¢ 1{Unit s 21) (Out: 1, In: 9)
Point [Start Special 1
Application] LB s | e
L8 oo SacAEm ’
@ o8 09[0000] Erpky Slot Unit Setup
[+/-4ag, [0000] Rack 01 Save Parameters
Load Parameters
plication
Select [Start with e i
. . a5te Tl . .
Setting Inherited] pat o Start the MCH Unit as registered.
‘ Ui anuFacturing infermation |v -
Unit Errar Log line
- HotSwan
5% Mewroject - C3-Hotion-MCH “mj_:_zj
|| e v vest g 1o et
[oEa «= & ‘-‘*-l"".- mid |t w |[oeEEg
<R L”&’L‘Hl' DX E& jiiQd " |
Add task, axis, program,
and CAM data
L3
B Motion Progams
"2 Progremy
b?imswhwm
R [F] [E] | Click to add task, axis,
e program, and CAM data.
= 3
o
AT, Cowmpie { Taaries [
e i |
[Taryet$100 {3) : mewirogramd {17] =
. . Yo £ yem fremt Grinm Tosk wedws teb - : =18 x|
Edit position data, DGR «#R&  Be - AT v R | DERRE (550000 |
parameters, program, e s T e e [l 3
and CAM data T:nﬂl;,;m._.l,l HIVE 'Jnnulnnu (702150000
7 b T == 1
mg::,;:ﬂ mu-,l}:uu 130275000
Uik Satige E (1011100000 021100000
1 maln-'wmn.-. 1 : i
8 D ekt 81 :
B huimtrp ;
7 houl.'“ .
| Jrosity

Open the editing screen to edit data by double-clicking
position data, parameter, program, or CAM data on the
project tree.

A Gub Progae
Bl NewSutProgenton 1500)
SN N

-

S |
[STTTETRR, Compue £ a1

3 [ tnz, s Bl

Save the project Click E Iand save the project to file. 2-8
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As with Analog Unit registration, register the IN and OUT Units.

T | PLC I0 Table - NewPLC1 S[=]

Eile Edit Yew

Options  Help

Register basic 1/0 Unit

=]

- CHM-CPUL3

[+ 4gg, Inner Board
o000, oin Rock]
3 00 [0000] CI1W-1D211(DC Input Uit}
- ?I 01 [0001] CI1%W-0021 1{Transistor Output Unit)
-§) 02 [2210] C)1%-AD0R1-Y1{Analog Input Unit § points) (Occupancy © 1)(UNit : 210 (Qut: 1, In: )
-5 03 [1550] CI1%-NCF?1(Position Control Unit) {Unit : 2)
% 04[0002] Empty Slot
3 05 [0002] Empty Slat
-5 06 [0002] Empty Slot
-5) 07 [0002] Empty Skt
~§) 03 [0002] Empty Slot
% 09 [0002] Empty Slot

&, [0002] Rack 01

In this example, CJ1W-1D211
and CJ1W-0OD211 are selected
as IN and OUT Units respectively.

CILM-CPULS

[oFfline: 4

By registering Units to the I/O Table, you can check I/O assignment status.

Check 1/0 assignment

Ay,
&

£

7 Clim-cruls
Inner Board
[0000] Main Rack

021 1(DC Input Unit)
D021 1 Transiskor Oukput Unit)

01 [0001] 114
02 [2210] CI1%:
03 [1550] CI1W-RCF7 1{Position Control Unit) (Unit : 2)
04 [0002] EmpygSlat
05 [0002] Empty Slot
06 [0002] Empty Slot
07 [0002] Empty Slot
05 [0002] Emply Slat
09 [0002] Empty Slot

+- 4, [0002] Rack 01

In addition, you can check addresses
assigned to actual I/O with a print out.

D0E1-v1{analog Input Unit 8 points) {Occupancy @ 1dUnit @ 21) {Out: 1, In: 9)

FLC 10 Table - KewPLC1

hsalog Inpat Usit 8 =41} (21}

[022100.91 I use gettieg  cEnable(lhex):

Dzz100.1] use seltimg  <Disable]DHex)s

(022100, 2] use gettieg  <Disablei0Hex)>

Dzz100.3] use settieg Disoble|DHex)

[D22100.4] ue oo <Diable|iHex) >

[D22100'5) <D sahlefOfiex )

[022100.61 <Disable{ e >

E-_\n 0 }; ing  ¢Disableiifex):

1221010 1=V 4=20mA( 2Rex) >

E..m 1 r; a1 00 (M) 5

122101 . 4 10%{ OHex ) >

(De2101 6] Vi e ) >

[ozzion e ) 10%{ OHex )

{bi2101.10] (0H

jDzz101.12] ol 10 [ Dlex) 5

{o22101 14] w0107 OHen) 3

{D22102] Input] Mean valus precessing sstiing  cHean valus precsssing

[pe2103] Inputl Kean value processing setting

E 231 1} Inputd Mean valus precessing sstting
23108 Inpatd Mwen valus processing setting <M
22106 InputS Mean valus processing setting o lue precessing
37107 Inputé Mean value processing setting  <Hean valoe processing
22108 Inpat? Mean value processing setting <Hean value processimg 2 bui

E 221081 Inpat$ Hean value processing setting  <Hean value processing for 2 buf fers{0He
22118.0) Operation mode setting tBornal mode(0Bex):

E 127118 8) Conversion time resclution setting  ¢1as d000{0Bex) >
102210.0) Inputl Peak value hold ot used(OHew):

[CI02210 1] Input? Feak valus hald used | OHax)

[Cro2210.2) Input} Peak value hold wsed ( OHew ) »

[CI02210 3] £ waed | DHes 3

CI02210.4] e { Omx)

CI02210 5] waed | DHes 3

fcIoz210.6] 1 wmwd{ OHmx ) >

[€162210.7) Inpuré Peak value hald used | OHa) >

This I/0O assignment information can also be checked by 1Q indication (IN:I, OUT:Q) during
ladder programming.

0
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Design

Right-click from Function
Blocks

—

Select a folder from
[Omronlib] > [Position
Controller] > [NCF]

—J

Select OMRON FB Library

" NCF021_MoveRelative_

DINT12.cxf
Enter “MoveRelative” for

instance name. Then
create a ladder program

Starting CX-
Programmer

Creating Unit
Configuration

Programming

Setting
CPU Bus
Units/SIOU

Checking 1/0
Assignment

Programming

Offline Debug

Saving

a Project

This section describes programming with Library (OMRON Standard Libraries) that allows

easier connection to OMRON’s Components. OMRON Standard Libraries is a group of

Components provided by OMRON, which can be categorized into two types; FB Components

(OMRON FB Library) to be used for a ladder program and SAP Components (Smart Active

Parts Library) to be used for an indicator.

@® NCF Unit Programming with OMRON FB Library

Servo motor (axis 1) connected to Unit number 0 NCF is moved to position 2000
(command Unit) with speed of 2000 (command Unit/s) by relative move command.

2000 Command Ui

Velocity Command __| Velocity

& Unit No.: 0
CPU NCF A4
Servo Motor No.1
Servo Motor (Axis 1)
[ =1 (Axis 1)
W10.00 W10.01 W10.03 W10.04 W10.05 W10.02
Start Tnnger }(ENO)} }Done‘ C }/“d }Error !
omman
Start No.2
W10.02 ‘ Aborted
Il |
1 f
Start No.2
P_On (Normally ON) _NCF021_MoveRelative_DINT ENO
[ — (BOOL)
— (B0OL) ENO S
UnitNo. __| UnitNo (BOOL) |_ Positioning is completed
&0 | (NT) Done | W10.03
Axis No. __| Axis (BOOL) | Command is aborted
Axis 1 - &1 | (INT) Command Aborted [ W10.04
Start No.2 _| Execute (BOOL) | _ Error Flag
w1002 ~ | (BOOL) Error
Position Command __| Position (WORD) |
2000 Command Unit - &2000 | (DINT) ErroriD (Omitted)

nit's —> &2000 | (PINT)

=52 NewProject
2-T0 MewPLCI[CILM] OFFline
5 Symbals
@7 10 Table and unit Setup
. [5) settings
g Memory
=% Programs
E-55 NewProgrami (00)
-2 symbols
- sectionl
L6 END

N

ob) Cut
Copy.
2 paste

Delete

[ alow pocking
Hide

Eloat In Main Window

3 Properties

Select CX-Programmer Function Block Library File

Loak jn: I {3 HCF

=] _NCFO01_Connection1.cxf

a _NCFO10_Moveabsolute_REALLL.cxf
@ _NCFO11_Movedbsolube _DINT11.cxf
a _NCFO1Z2_Movenbsolutez REALLO.CxP
a _NCFO13_Moveabsolute2_DINT10,cxf
@ _NCFO20_MoveRelative_REALLT cxf

K

5F Structured Text

From File. .

el o RERCIT,
_NCFO23_MoveRelativeZ_DINT10,cxf
_NCFO30_Movevelocity REALLL.cxf
_NCFO31 _Movevelocity_DINT11.cxf
_NCF040_TorqueControl_REALLT cxf

i

File name:

LNCFU21 _MoveRelative DINT11.cxf

Open I

Files of pe: IFumctiom Block Library Files(*.cxf)

j Cancel

A

I\ Proiect /

=

Call the selected OMRON FB Library on the ladder, then enter its name (instance name)

(in this example, “MoveRelative”). Then create a ladder program as shown below.

I [Pragram Marme : NewProgrami] -
-5 NewProject —
= BB MewPLCI[CILM] Offline [Section Name : Section]
S Symbols
-} 10 Table and Unit Setup W00 W0.M W03 Wi0.04 V10,05 WAD.02
settings — I | | % % 14
< Memory StartTriguer ENG Done Pause ErrorFlag
=% Programs wiooz
-8 NewPragram (00) I
23 Symbols Startz
B Sectiont 7 I l
-E@ END 7
el 8 jﬂmﬁ, GIECE TN
F _NCF021_MoveRelative_DINT b on Bo0L) (@000 wioo
L En RS
Alvvsys ON Flag
20 (T (EooL)| w03
unitfia Donel  pane
21 T (0oL winod
s Command_Ak | pause
orted
wion2 8oL (B00L)|  winos
Start2 Execute Enori Errorflag
22000 (DT (WORD)
bistance Errori|
22000 (DNT)
velocty

OMRON FB Library is a collection of Components that OMRON provides as a Function Block
to use functions of OMRON's Units for PLC and FA Components much easier on a PLC
program. * For details, see FunctionBlock StructuredText Introduction Guide, Chapter 1.
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How to use Smart Active Parts

This section describes how to use Smart Active Parts. In this example, NCF Smart Active Parts

Select [Library] from the
[Tools] menu

Place Smart Active
Parts on the screen.

“Adjust Operation” is used.

From [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Designer] > [CX-Designer
Ver.O] to start CX-Designer. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-Designer] >
[CX-Designer Ver.].) Select [NS8-TVO0[]-V2] and [System Version 6.0] or later.

Tools i window Help

B Test... Chri+T
© "
. 5 PLC Error Simulator
e
.
..  Resource Repart...
° alidation 3
0
.
.
® D5F| DXF Explarer...
.
.
.
(¥ Lbrary... Alt+4
E

.

'-H—n—ﬁ-dlg Tt ZIM e e B

1. Select w:_
SAP - SmartActiveParts_E =g ——— 13540 ——
- Motion - NCF - e, g ':)w Disdble J%x G umwﬂmmﬂ
OutCIO_InCIO folder £5 T | s o] Bl b e
2. Select NCF001_xx B
_Adjust Operation RLTTT I | |65 g e
(Check the Title) ) o e
3. Drag & drop it on the
screen. 4. The selected Smart Active Parts are SAP Communicalions Selting
displayed on the screen. Destination Adess |

Setup Smart Active
Parts

Command Destination Port Name SERIALA <

Axis busy  Override setting - Speed CMD walue (0.1)

0 33
O [ Disble [[20000 % | +d06 || oom0o00m |V [pulserss ¥ | P

1. Double-click

2. Set 4 to the Destination ****""""

Unit No.
3. Click [OK]

Smart Active Parts
Setting is complete

[ stirration Wode Aotizss 0 =

o® [xis| 99 Decel.stop| Servo unlock| -JoG | Urig.search| Orig. retum|

I™ DeviceMet Slave Addiess 1} 3:

.
oo
eo°
eo°

Setting Smart Active Parts Communication address
Please wait

Axis busy Override setting S Speed CHD value g0

) [Dissble |[ 999,99 % | +306 || 9999990999 |V [pulsese [V |

Setup is completed at 100%

is| 99 Decel. stopl Servo unlockl -J0G | Orig. searchl Or\g returnl

4. Communication address is
automatically calculated according

Save the Project.

Refer to Page 2-13 “Saving Project” for details.

2-11
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Click @

(Simulator connection button)

CX-Simulator debug
console is starts

Starting Switch Box Utility
Select [Tools] >

[SwitchBox Utility] o

Run PLC

. . Setting
Crea_tlng U_nlt CPU Bus
Configuration Units/SIOU

Offline Debug

Checking 1/0

Assignment Offline Debug

Programming

Saving

a Project

This section describes how to debug a program using CX-Simulator, a ladder simulation tool,

without the PLC.

Additionally, Switch Box Utility is used as a virtual input tool.

™ Untitled - CX-Programmer - [NewPLC1.NewPrograml.Sectionl [Diagram]]

E\Ie Edit Wiew Insert PLC Program Isols Window Help =~ ;Ii')d
e I R L T ek IEEEEY PR - Ty
aoqiEEEERTrwirw | —0FTTET % |2 S| % u B EEE |

Ery

DEEROE & 20 E

| 4 28 |

=

Program transfer starts.

Program Download to PLC MewPLC1

ar

Transfeming programs
Biyte 43736 of 53364
Downloading...

i

Screen when online

% Untitled - CX-Programmer - [[Runnip—?

*--2LC1.NewProgram

Tools Window Help
Bickiuasl "

File Edit View Insert PLC Proorf Tooks [isdere ek o A
-
- 5 o 0
DSH[R(SR| BT - a5 2 A 48 ee-dr i & &)
a0 Qs mER A | —osEEEL bk || &e] %0
CEEAROSE &= 8 2005 |
= Keyyboard Mapping. ..
a fo [Program Name : NewProgram] = P
=] % MewProject @ Options. ..
E--% MNewPLCL[CIIM] Monitar Made [Section Mame : Section1]
o ST
ntor Del
Wi0.00 0.0 W10.03 Wi0.0d W10.05 Wi0.02
— I i | s s 14
o StartTrigger ENO Dane Pause ErrarFlag
. [y Error log Winm
&) PLE Clock —
g Memory Start2
-k Frograms 1 MoveRelative
=%} NewProgram1 (00) Runring 7
) Symbals _NCFD21_MoveRelstive_DINT
Sectionl
P_an BOL; BOOL Wi
----- 5 eno S s EH |
E‘“ﬂ; [ [Monitor On][Network:0,Node:0][Untitled] - SwitchBox: _ ol x|
T File(F) View(y) PLC(E) Address(A) Help(H)
J IUnl\t\ed Group j
Bit Manitor -
| il | Eomment Eomme Address [ Value Comment
Wy10.01
Wi10.02
Wj10.0%
Ww10.04
W10.05
il [ s o | < | _'l_l
F1Pragram [rznonisor JFarun Fa(Debug) ‘FSAutn Online IFESa\act Port
F7Bit Moniter |F9.EI Monitor ‘rgwmn MomtorIF’lDComment ‘FHGIp.Commen'IF'IZNeMmk Set ‘
o [@ [cam-cruna PRG  |HEX ;'J
', Project / 2 = Mame: Address or Walue: | Camment: |
Far Help, press F1 o |NewPLC1{Simulator) - Monitar Made [ soms [SYNC [rung 2 (0, 0y - 100% [ 7
K
Switch Box Utility
It is useful not only for virtual input by simulator but also for debugging 212

while checking the PLC’s wiring or setting the DM and other initial values.
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Saving a CX-Programmer file

From the [File] menu,
select [Save As...]

Saving CX-Designer and
CX-Motion-NCF/MCH files

2-13
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Unit setting, Unit parameter setting, and programs using the CX-Programmer can be saved all

at once.
™ Untitled - CX-Programmer - [NewPLC1.NewProgram1.Sectionl [Diagram]]
File Edit ‘iew Insert PLC Program Tools Window Help =& x|
[y ak 1@|oc (#atE(eR|[e2B8aL [RERARESREDRED |5 W%
- [ Open. Chri+0
g [Rarsuw | —op L k||Z (e «%y % BBEERER |
[0 5o cles |0 4[5 | % 28 |
= w o o| JJ FProgram tame : hewProgram1] =
B Reusable File 3 .
[Section Mame : Section1]
Function Block »
wo.oo wio.m w1003 w1004 w1005 w002
Load Camment /Pragrarm ]} |} 1} |1 |4
Save Comment{Program StartTrigoer ENC Done Pauze EtrorFlag
Wi10.02
Ba Compare Program. ..
Start2
Page Setup...
3 1 MoveRelstive
@. Print Prexyiew 7
é Prirt... Chrl4+P _MCFO21_WoveRelative_DINT
| DINT
1 Samplel cxp (4l F_Cn (BOOL) (BO0L) WA O _"d
g Exit | x4l Name:! Address or \u'alue [ Comment: |
Saves the project with a new name |NewPLC1{Net: 0, Node: 1) - Offline [ |rung 2 (0, 0} - 100% [ 7

&

Save it with a name. In this example save as “Samplel”.

Save CX-Programmer File EH
Saven Ia Demo j &= ¥ B3

Pr—
File name: ' Samplel i L Save I
Save as type: IEX-PlUglammer Project Files [*.cxp] j Caneel

Y

essssee Click

Created data can be saved for CX-Designer and CX-Motion-NCF/MCH.
Save CX-Motion-NCF as “Sample2.mnf” (CX-Motion-MCH as “Sample5.mnh”), and CX-

Designer as “Sample3.ipp”.
Saving screen for CX-Motion-NCF

Saving screen for CX-Designer

- @ ot E-

|SampI53

Save I

Save HE Sawe Project As
Save n: | ‘=3 Dema M Ko £ B3 Save jn:
. 0
. D
. °
. °
. °
° °
. o
. °
. .
. .
. D
° .
. .
L
o
File name: ISampIeZ . Save I .He name:
.
° .
Save as type: |0 Matiare M CF File(* mrf) x| e Cancel | S saveasype [P
a 4 .
°

oject fle(*.IPP)

=l Cancel |

4

If you run a dedicated Support Software such as CX-Motion-NCF or CX-Designer when CX-
Programmer is started, the same default folder location as that of CX-Programmer is used for
reading and saving files. It allows easier CX-One Support Software file management.
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a Machine rojec to PLC Machine

Program
Debug

This section describes connection to the machine, transfer of programs, creating Unit settings

offline, and how to debug.

Reading a Project

From [File] > [Open], select
the file name “Samplel”

or ST |telasEy s
g < AW | — Ot k||

\d 1!
Click E’-‘-l < LICT I Y]

(LT =

[ ]
Fimol i [P Pt i [ ool %] Cancel j

Pow e, proms P

Ladder program “Samplel” is retrieved.

[D#@ @ 8n i ne

ICREROS B RAECE L e ]

auE reareaLn=as AR

s [CSEmERk e | —osT@ELK (¥ aFSuns MBIED

o g

B

T reromat '

B2 et CA[CIM] T  actcr: b | Snctior ]
2 Syt

e f

I+l

P o, e P

Use CX-Programmer to read the project “Samplel” saved in the previous section.
001 x|

In 1/0O Table Unit setting function, the Unit parameter setting configured in the previous

section is also retrieved.

Double-click the I/0
Table Unit setting "***«.., |

T 04 [0002] Empty Sot
B 05 0002] Empty Slot
1 06 [0002] Empty St

=y [0002] Rack 01

CHMCULE ol
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Online Connection to PLC

Verify that PLC model and communications setting created offline and the actual PLC are

correct.

Double-click PLC ==ssssssss

E% Programs
EI@ NewProgram] (00}

2 Symbols
Sectionl
: B EnD
EI 3} Function Blocks
Lo _MCFDZ1_MoveRelative _DINT

L Project §

Check PLC model.

General |

]
™ Read Only
o |

I~ | Read drily
File Memor
[ Nane - I~ Fzad Only ‘
Timer / Clack.
’V I¥ | Installed ‘

Make Default

Program
Debug

Change PLC

Devica Type
’7|uw t Settings '
Network Typ P
( T I |
Comment—#® — y A

|
[- |

0K | Cancel |/ Help

Check communications setting.

Network Settings [Toolbus]

Network Driver | bodem |

Connectian

FotName: | [EATSEIN .~
Baud Bate: | 9600 2

¥ Baud Rate Auto-Detect

Data Farmat

DataBie: 8 -
Barity: None ¥
StopBits 1 >

Make Default |

Confirm that automatic

communication speed recognition

is checked.

ok | teel | Hep | ,

= Samgle ] - C-Programmer - [New?L | sewfrageam | Section] [Diagram]]

. [ Ee Bt Yow Jwi R Brogam Toock Wedow Help
Click /2, | n---------------me--a-a-a-uag.....uht.n APEETEERSw|a-
2 aaQ|fizimEm ia-ﬂﬂ-‘li"wl—-o 2 omysnt MBEED

(Online connection button) DERROF @208 L85
= T | :'. -
?MFI[HIH]UM [Secton Name - Secton!| @
£ Tyl o
13 Vbl and Uik Satup BT R ‘W’"‘ wAD o3 W winos winm |
Sektings A 1% 1+ / L |
o Moy B Peue ErrixFlag
T G opsi
i . . = ' Movefinlaive
If a connection cannot be established with the PLC, : [ ——
- . - ik (s kmocs s n |
you can use the automatic online connection ;.f."?—,r?f o T "
1 Wyt ON s | | 28
function. Ul p o . |
I_:I W Nm Mn;o_u\‘_dfr_: \?’lﬂ.ﬂ} Comment; StartTrigges

e 01 06 63+ 1P

Save your current project data before using this
function because it clears project data being edited.
When USB conversion cable (CS1W-CIF31) is used

for connection, specify the COM port number of the | & 2o et o e —
USBportused b égﬁt" AR R (asERlLn RORASE BTEER ~ b | % o
0 1 T (|l AF4F 4R | oo B HFRLL K ."' Wy e REELE
CRFROS @-0 - @ 8805 v
% - x i g [ Prowem Nt tewProgram1)| j
EEmsmEsmEEEEEE . oy
) . wiigd ' wiom winn WD winDs winm |
(Automatic online el - e |
connection button) _.“""g ‘
i ‘P‘Wu:s ¥ s S |
& NewProgram (00 Sopped T
22 Symbats _HEFU Woweltelative_ONT
gx"" " ) L Wi |
i ;'_':}&'medmmu 141 Sexacineg | ﬂﬂ
2-15 Progoct f o Giokal poame: et or Vit TWIEL00 Conutert: FtartTrpoer i
Fer e, press FI B Cl{ntl Moo ) - StopFrogramHode | SMC gD, 0) - 100%
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Transfer programs and Unit setting parameters created by offline project to the PLC.
In this example, data is sent at the same time to various Units using the batch transfer function.
[Data to be sent]
CPU Unit; Ladder program and PLC System setting data, 1/0 Table data
CPU Bus Units and Special I/O Units:

AD Unit: Range setting of inputs (1~5v / 4~20mA mode)

= Sample1 - CX-Programmer - [[Running] - NewPLC1.NewProgram1 Section1 [Diagram]]

' [ Ele Edit View Insert | pLC Program Tools Window Help & x|
Dﬁ,nh@‘é[@wmomm e+ ?‘F’iﬁ%‘&"l@“@ﬁ‘& & zoam ez .
ok orline Simulator CHIHSHiFEY
ECNEEEN sEEELK||B]Sammss \m|=|5|@|@ |
mERRD Auta Online »
53
——— OperatingMode 4 e =
= B NewProject Hanitor »
BEs U o o st fetiont]
=5 Symbols (%] Compile Al rOgrams
Select [PLC] > [Transfer] Seean, § 10 Table and L Program Check Options... — — — —— ——
> [TO PLC] ® ® 0o off settings Aubornstic Alcation.. i vt ) "
EE Me%d‘ryta.d. o ofggen As;,gnments Endl Done Abort Error flag
Error log
PLC Clock Function E\nck Memm[ ®ee, [
2 E%”qr:‘“: _ Esrtial Transfer s
_Eews;fni': Brotection » R Compare with PLC. . -
Clear All Memory Areas
@ sector S ! Ta File... oOLY wio
o Y FromFie.., ENO
= ZF Function Blocks —
- MCFO21 1
I ! Ly Data Trace... 50 (T (BOOLY WI0.03
Time Chart Manitaring. . Linithio Done Done:
” -
Force » _’l_l
\ Project / S 4 Address or Yalue: [W10,00 Camment: [Start
Transfers data to the PLE (downloads) [NewPLEL{Met:0, Node:0) - Run Mode | 1ams [svnC [rung 0 ¢, 0y - 100% 4

=

e b

.
.
Includs ., o
.

%4 Frogramis) .
o

[If& settings ..
187 10 table d
[Jm# Special Unit Setup Transter Al
‘= Symbols

- [E] Comments
- W 32 Progiam index

Click [Transfer All] ..

i~ Symbols, Comments, Progiam indes:

Transfer Ta/From:  |Comment memory v

& Transfer files of 2l tasks

£ Transfer files by the task

¥ | Clear program memary

= Exelude Port{HostLink, Paripheral of PLE Settings fiom the
branster target
[Check when tansferng CPU umit seral comms part settings:
changed by NT Link auto-online ar CFL unit parameter edit of
[54:| rtegrator |

Program and configuration data
are transferred at the same time
to CPU Bus Units and Special
I/0O Units.

Transfers all the data ko the PLC, Do you wish to continue?

b .;D..]....... =+ Click [Yes].

Program transfer starts.

: C%-Programmer v 6.0

F"wan-beﬂ'nF‘LC NewPLCT

 Click [OK].

Next Page

Domrioad faded

CJ1W-ADO081-V1
Unit No.= 21

CJ1IW-NCF71
(CI1IW-MCHT71)
Unit No.= 2Hex

CX-One CJIW-0C211

Connection Cable
CS1W-CN226(2m)

CJ1W-DRM21
Unit No.= OHex
Node Address= 01

=

PLC1
CJ Series PLJ CJ1
T
0

EEEE& il

= TN CIIW-CLK21-V1
CJiw-ID211 Unit No.= 1Hex
4 ~ 20mA Node Address= 01
. Termination Resistance
Connection Cable Setting= ON
XW2Z-200T(2m) 9=
Servo Driver
R88D-WNO1L-ML2
2-16

— —— CJIW-SCU41-V1
g Unit No.= 3Hex
&

=2,

Vi
NS Series PT

NS8-TV00B-V2
System Version 6.0 or later

Sensor
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Then data is sent at the same time to NCF Unit and the servo driver connected to NCF Unit.

[Data to be sent]
NCF Unit: Common parameters, axis parameters
Servo Driver: Servo parameters

From CX-Programmer, display the 1/0 Table,
then start CX-Motion-NCF by [Start Only].

[ PLC I0 Table - NewPLC1 == B3
Eile Edit Wiew Options Help

- CIM-CPULS
/- 4ag, Inner Board

g g c 4 [0000] Main Rack
nght'cllck NCF Unit A ¢ f) 00 [0000] C14-D211(DC Tnput Unit)
L] + 5] 01[0001]CILW-OD211(Transistar Output Uniky

7 02 [2210] CILW-ADDB1-VL({Analog Input Unit & paints) (Occupancy @ 1{Unit @ 21) (Out: 1, In 9)

- WF 7 (Pocition Cortrol {Linjt ; 7

|8 Untitled - CX-Motion-NCF M=l E3
Fle View PLC Unt Help

Sl (6L a8

.
] H
.
®e

kol Uity (Uit 2%

7 05[0002] & Change / Confirm Units
7 08 [0002]Er Unit Comment

-~ 1) 07 [0002]Er SySMAC BUS Master »
7 08 [0002] Er

(

. . : ¢ Uit Setu
Point [Start Special o Tovor ok sovpaaretr
q ] ®eq, Load Parameters
Application] Peecea,,

a

Start with Settings Inhered

T
o
acffiic
il

Copy
Eogce ©
.
0®®® Belete

{

| Uit fanufackuring informatian

. coo®® °
Uit Ef L
Click [Start Only] e — . Pres 741 o il . o

Open a saved project and transfer all NCF Unit and servo driver parameters.

To prevent a servo driver operation using a ladder
program, you must set the PLC to PROGRAM mode.

1 Untitled - CX-Motion-N =] 3] & Sample2.mnf - CX-Motion-NCF [_1O[x]
Enam PLC Unit Help
ST

sl
%

Look jr: |4 Demo = = E ek E- %
DEMO

Samplez., mnf

{

Click @ |

If it does not go online, click @
and check the communications
setting between the personal
computer and PLC.

Select “Sample2.mnf”

e
File nam; S ample2 mit K L Open [
°®

Click Open N = e T R
A

Press

Press [F1] to display help. [ Y

|&#Sample2.mnf - CX-Motion-NCF [ O[]

{58 sample2.mnf - CX-M ;IEIEI
File Wiew PLC Unit Help File Wew PFLC Unit Help
==Y O A& gl
T2 T T 6 11 W-NCF 71 Axis Map

“§l Bie Edit Onlne Help

. f El@] x| wreles]
...' B “ofl wis 01 New Driver 01(RBED-WNOTLAMLZ)
Double-click NCF Unit **

U GGIG

e P e ey e, [ Press [F1] to display help. T T =
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Click EI 'il

Click

Click [Online] > [Test Run]

Reading

Project

Online
Connection
to PLC

Transferring
toa
Machine

|EECI1W-NCF71 Axis Map E

File Edit ©nline Help

J 0.02 1[C MCF71];
B Awiz 01 New Driver 01[REE0-WND1L-MLZ)

Program
Debug

Download to NC Unit E

Download All [Computer to MC Lnit]

@E

Acquinng Access Right...

=

The Unit restart confirmation screen will be displayed during data transfer. Click the [OK]
button after confirming safety. Also, in the case of communication was not established
between the NCF Unit and the servo driver, confirm the axis number and restore power to

the NCF Unit and servo driver.

When parameter transfer is completed, confirm that communications is performed normally and

has not resulted in an error.

Monitor the NCF Unit. Confirm consistent scan list (axis configuration) and communications
status and that no axis or common Unit error has resulted.

&8 C11W-NCF71 Axis Map [ %]

Flle Edit ©nline Help

iz (1 New Driver 01(RE30-WHOTL-MLZ)

Unit monitor - New NC1 [Monitoring (connection established)]

&

{Siatus | Present positan |

12 3 4 5 B 7 B 9 10 11 12 13 14 15816
Scan list BTN orr Jore | oreorr | orr | orr | orr | orr fore Lorr ] orr | orr |
[ EETET T ore | ore Jore lorr L orr ] orr  orr | orr fore Lorr ] orr | orr |
Auis enar ]
Urit commaon exror Error Reset Al T . t
Eiorcode 0000 erminate
Error name:

Unit monitoring.

Next, perform jog operation. Carefully read the displayed cautions, then perform the operation.
To perform jog operation, it is required to establish a connection, servo lock, and jog setting.

| CI1W-NCF71 Axis Map

File  Edit ’ane Help
y | Download to MC Unik
[E]

Upload from MC Unit
Compare

wNO1L-MLZ)

Write Flash Memary

Unit Monitor

Device Information

Test Run n
~ Selected A Statu
“ (Comm wh)| By B Precent Valuel 0 Cormand Uit
r~ Establish/Release Connection —JOG Setting:
Speed Designation
’V 5000 Command units/s
@ i ;I[ Rel
eesse Oweride
Established ’Vl_ Enable 100 %
~Servo Lock/Unlock M
JOG Button————————————————————
ﬂ Servo Lock
In Servo Unlock 4 h
[~ Unit commar emor [~ Az ermor
Error code | 0000 Feset Error code IIJEIIJEI Fesel |
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Click &)
—

Select file .mnh

—

Click [Open]

Click (@] searesreesseenniiei

—
Click
—

Select [All Data]

]

Select [With Servo
Parameter]

]

Click [OK]
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When using the MCH Unit, transfer data from the CX-Motion-MCH to the MCH Unit and servo
driver connected to the MCH Unit.

[Data to be transferred]

MCH Unit: parameter, position data, program, CAM data.

Servo driver: servo parameter

Display the I/O table from CX-Programmer and start CX-Motion-MCH with [Start Only].
(Refer to NCF Unit for starting from the 1/O table.)

Open the saved project and transfer Unit parameter, position data, program, CAM data, and
servo driver parameters to the MCH Unit.

To prevent a servo driver operation using a ladder program, you must set the

PLC to PROGRAM mode.

{18 Cx-Mation-MCH

=1olx|

2 2R |mFREE i AnEER

SET

File yiew Tools Help
@\«»|@.5\%E|QQ|M-‘

Look in: | ‘=3 Deme

[ e = =

X

DET

File rame ‘
Files of type: [ 2¢:MationMCH Project Files{* mh) 7], o8 Carcel
.

EEEEEEsEEEEEEEEEAgE

I\ Project /
=l
W, Compite £ Transter /-
Edit [ v
{:® Sample5 - CX-Mation-MCH i [=] 5”

Ele Edit View Insert Orline Tools mnduw!uslp

=)

= f NewPLC1
B Tagatsiou

Urit Settings
Taskcn = 8 %

B NewTask1 (1]

peRAernomx {a Joan

r~ Select MCH -

< = Al Data

DEE Hh B&|sme|de nie 2R |nEEE

pecied Data
| System Parameter

If it does not go online, double-
click PLC in the project tree and
check the communication
settings between the personal
computer and PLC.

LA - H
.----l""' (- By dues
- [ Motion Programs

"7 Frogams s (it Servo Parametsr
i -
[ HewProgram 0. © Without SeTve Parameler
. 2] Nev g m
E'-"'z‘s‘wh'ams [P Pesitzn Dt |

aus®® NewSubProgram500

auns® . B CaM | Rromram
anse®® : B Hentant1 (1) ] C lrlvid!
v
4] m
Project
:I -
| [P cennes | =l
sssEEmEEEm . Cancel
IIIIIIIIIIIIIIIII IIIIIIIIIIIIIIIII LI
AT, Compile A Transfer
= ‘ l lontine 7

The Unit restart confirmation screen will be displayed during data transfer. Click the [OK] button
after confirming safety. Also, in the case of communication was not established between the
MCH Unit and the servo driver, confirm the axis number and restore power to the MCH Unit

and servo driver.
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This section describes how to transfer screen data to the NS through PLC without changing

Online Debug on Reading Connection to a
a Machine Project to PLC Machine
Transferring NS screen data
Start NS transfer
cables.
program

From [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Designer] > [CX-Designer

Ver.] to start CX-Designer. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-Designer] >
[CX-Designer Ver.].) Open a project saved in the previous section.

Select [Transfer]-[Transfer[To PT...]] from the [PT] menu.

Click on Setting

Yes |

Do you want to start transferring?

- Menster Sstting
Teee.,
Mo settine

:
o |

I~ Do not ghaw the dialog again

*Communication between the NS and the PLC
must be established before transferring screen
data through PLC without changing cables.

If “Connecting...” is displayed at the right bottom
of the screen, use Auto Connection (See Chapter
3 1-3 “Setup NT Link”) to connect the NS and the

Setup
communication route

—

e e
Check “Pass thru PLC”  seseseececes®®® P it SRR
in the Comm. Method 1 e b st L
window ; AR SRS
£ =] ] E {1 [Casria ::51
1 —i—
EA
[ HiE T
A | N |
= l-ll--ll--ll-

Select Serial(Toolbus) .,

o,
L3
.
.
.
.
.
.
o,

Select NT Link ...

®e
®e
®e
®e
.
o....
e
®e
®e
®e
e

[ Data transfer to the NS thiough PLC

(1)Comms. Methb]

.
[ SeralToolbw = I

Setup “Data transfer to
e.., the NS through PLC".

N elwnrk]

Transfer screen data

Auktrroaset atel the hanamision

Click OK to start transfer

[ Auskoimnt e
[——

. Fimm— =1 4 )
. —

., —

i«

Comms. Flocke
¥ Paus thoough PLE

. 2
= pelbiehs

T
PELPLE oot oPLCA5
Dota e o he NS Hrough PLE

Cosculer |
11 comms, Mo
sematloots =] S0 |

P
PC
[Phstra]
1

12 omem. Method

o)

)= =

PLC before starting the following procedure.

If the communication between the NS and the
PLC has already been established, you do not
need to perform the operation described above.

Check “Pass thru PLC” to activate

the “PC - PLC > NS’ route setting.
 Comms. Route——————————————————
[ Fasiimh Pl .

@ PE[ ]PLE[ ]NS

(1 2l
|‘ﬂ PE———PLE‘—VNEtwmk]———FLE——NS

‘s Select PC — PLC — NS.

Fon 3 «eeeee Set the serial port

L COM No. for PC

it | - PLC connection.

lem. F Then, press OK.
|

Press each setting button.

=

Seiial Setling

Port HSZSZE

- «ses Enter NS Unit No.

Urit Mo.(0 to 7)
Then, press OK.
Cancel

Transfer/Computes->PT|

y

ENEEENEEEEENEEEEE
Mo downlanding[ 53]

Screen data transfer is

complete at 100%. 220
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Program Debug

Transfer programs and Unit setting parameters created by an offline project to the PLC.
In this example, data is sent at the same time to various Units using the batch transfer function.

Monitoring

Monitor ON/OFF status of contacts and coils.

=i i gamplel - CX-Programmer - [Stopped] - NewPLC1.NewProgram1.Sectionl [Diagram]]
. m File Edt Mew Insert PLC Program Tools Window Help N =18 x|
Click =z | R LT e L e Ly s i L e e S e S L sy RS
GV EE R I A et e EEEIEEE R a1
mEAROG & E T

=

Cx-Programmer v5.1 E

Make sure that there aren't any problems if the PLC is started.
Do wou wish ko switch the PLC inka Manitor mode?

(4

Click [Yes] EEEEEEEmEEEEEEEEEE

rcﬁ:n . . . ON/OFF of monitoring

@ Eile Edit ‘Yiew Insert PLC Program Tools ‘Window Help -F il
DEE|k @R v oe|2c|ayn [t eeds L1 RiR el BTRR| L w|%-
sxaFEEMERC sy | — ool x||B|emuvsut EPERD |
CERROE & B 88E %
=48 NewFroject =l o o | [ Frooram Kame HewProgrem1]

= C ode [Section Name ; Section]
@7 10 Table and Unit Setup w1003
Sektings . 14 Frame color changes to
(5] Memory card StartTrigger  * ERO Dane r3 .
Eror g s a specified color during
(@) PLe ok — Function Block execution.
g Memory Start2
= Programs 1 MaoveRelative
-5 MewProgram! (00) Running 7
53 symbols _NCFO21_MaveRelative_DINT
- Fg Sectiont .
i BOOL; BOOL,
- [ END T o R i
=-4F Function Blocks Slways ON Flag
-JF _MCF021_MoveRelative_DINT
&0 (INT) BooLy|  winnd
{Unithla Daone b Done
o
1 (T (BooL)|  winnd
dixis command_&k | payse
orted i)
WiI0.02 (BOOL) (BOOL) w1005
Start2 +Executs Ermork  ErrorFlag
5 o
(DINT) (MORD)
4Distance Errari b
Current parameter e
value is displayed. ety
L4l | o
Y Project / %[ 4l[Global Mame: Address or Yalue: W10.00 Comment: [StartTrigger
For Help, press F1 |NewPLC1{Met:0,Node:0) - Manitor Mode [ Lems [svNC [rung @', 0} - 100% [ 7
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Monitoring -2 Changing the Current Parameter Value

Change the current value of contact or channel through conductive monitoring.

o

Move the cursor to D100
of input parameters

Right-click, then select

[Set/Reset (S)] > [Value RRRCTTo
(V)] from the pull-down

menu

or

Double-click

Or

[Program Name : NewProgram1]

[Section Name : Section1]

wi0.00 VD01 Wi0.03 WHD.04 Wi0.05 w002
— | | | i1 4 1
StartTrigger ENO Done Fause ErtorFlag
w002
—
Stert2
MoveRelative

_NCF021_MoveRelative_DINT

P_On (BOGL) (BOGLY Wi 0,01
Er ENO |
Alvays ON Flag

0 (INT) (BooL)|  wing3

Uitk Dorel  pone

0

&1 (T (BOOLY|  wingd

Jaxis Command_Ah - pause

orted

manmmny e

BOCL) (BOoLY|  wings
xecute Erorl  ErrorFlag

o

(DINT) (WORD)
Distance ErroriD}-

&2000 (DINT)
elacity

Change current value of the input parameter.
N
o

Address: |w1 0.0z Set

Data type: IBDDL 'l ance
Walue: I'I

0.7 [0CH)

’---------- CIICk

=

I [Program Mame : MewvProgrami]

[Section Mame : Section ]

W00 Wi10.01 W10 03 W0 .04 Wi10.05 Wi10.02
| { | 11 1 1
StartTrigoer EMO Done Pause ErrorFlag
W00z
Start2
haveRelative
7
_MCFO21 _MoveRelative DINT
P_on (BOCL) (BOOL) Wi10.01
EN ENO: |
Alwvays ON Flag
&0 (INT) (BOOLY W10.03
QUnithlo Dane Done
0
&1 [IMT) BOOL! w1004
Jasis Command_#6 L pause
orted 0
w1002 ‘ (BOOL) (BOOLY W10.05
Start2 Execute Errart  ErrorFlag
4 1 0
———| ) (AORD)
Distance ErroriD |

&2000 (CINT)
Jvelocity

Ensure to add "#" (hexadecimal/BCD)
or "&" (decimal) to the left of the value.

2-22



Start-Up /
Adjustment On-
site

Move the cursor on the
circuit you want to modify =========

You can use drag-and-
drop to specify more th
one circuit at the same

time

Select [Program] >
[Online Edit] > [Start]

Shortcut [Ctrl]+[E]

—

Move the cursor on the

Program
Modification

Parameter
Change

Unit

Online Program Modification (Online Edit)

contact you want to modify

and double-click

UG

Select [Program] >

[Online Edit] > [Transfer

Change]

Shortcut
[Ctri]+[Shift]+[E]

2-23

w1000 Wi w003 W10.04 W10.05 w002
I { | 14 1 11
StartTrigger ENO Done Pause ErrorFlag
Wi0.02
Start2
o »
MoveRelative
.
L _NCFO21_MoweReistive_DINT
"
n P_On (B00L) (BOCL) w00
" En =] HE S o S—
L] tvasys ON Flag
u
» : a0 T @ooL)|  winms
. . Urithio Done e
an . 5 0
. = & aTy BO0LY| W04
= [ [2xis: Commaned_ah [,
- [] orted 0
= u
= » w0z [@EooL) @ooL)|  winos
u n Startz Execite Errar Errorflag
" » 1 [
= u
» . £2000 (OINT) (WORD)
- Distance ErrorlD
L]
- [
= u
£2000 (DINT)
- " Yelacity
= [
L
U
o G
i
o [ Frosvam Mame : newPragramt)
[Sestion Name : Sectiont]
0,00 W00 W03 WH0.04 WI0.05 w00z
— { | i1 11 11
StartTrigger ENO Done: Pause ErrorFlag
w1002
—
Start2
1 MoveRelative
7
_NCFO21_MoveRelative_DINT
F_On (EO0L) (BO0LY
—En
EEEEEEEE RN EEERER RN ASASSEAESEEEENEEEEEEEEERRRRRS
80 ) (gooL)|  wino3
Alithio Done: Done
0
& (INT) (BOCLY|  wiD.04
Hnsis Commend_Ab | payse
orted 0
wino2 [(BooL) (BOOLY| W05
Start2 HExecute Errork  ErrorFlag
1 0
32000 (o) (HORDY
Ipistarce Errorbif
22000 (o)
Jetocty

{Progrem Neme : NewProgram ]

[Section Name : Section]

~—

Double-click

Enter the contact number you want to modify (W20.01 in a circuit example).

-{ )- Edit Coil

|w2t|_ il

| Detail >4

[Program Name : NewProgram]

[Section Name : Section1]

=

w1000 w001 Wio03 w1004 W05
— I { | o i1 i1
StartTrigger ENO Done Pause ErrorFlag
w002
—
Start2
Movefelative
_NCFO21_MoveRelstive_DINT snmnm
P_on (Bo0L) (BOOLY
En MG
Alvrays ON Flag
a0 (T (BooLy||  wino3
At Donet  pone
o
a1 (T (BOOLY||  win.od
Hais Commanc_2b [ pause
orted 0
wingz [BooL) (BooLY w1005
Start2 HExecute Errark  Errorflag
1 0
22000 (DINT) (HORD)
Jpistance Errorp
22000 (DINT)
Leloctty

w1002

ammmm?




Start-Up / p Unit
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. odification Change

Verifying Program
After modification on-site, you can verify it with the designed program and display the
differences graphically. This allows for easier checking of the parts modified on-site.

1. Read the designed program. In this example, read “Samplel”.
Then connect online.

=0 | 0|

I a2l

e EARAFIETER _w N
APPSR

Click E

(Online connection button)

Select [PLC] > [Transfer]
> [Compare with PLC]

Program Compare wih PLC NewPLCY

CX-Programmer ¥5.1
@ Compare failed

Tuaratreng pingrams

Byte 3968 ol BEOG

Compery
BERRNRNARNANRRNARNRNE

Click [OK]

Click [OK]  vawassmssssese=s®

You can check FB parameter

. I differences.
3. Display the verification result.
»
_{i x| ¥ Compare Result - [ Current Project, - Connected PLC ] 1 [=] 3
H File  View Eile  View _l -
Select [Section1] and = ——
CI|Ck [Detall VleW] smmmumusus ﬂij ‘tl Detail s | J Tl .)I Qyerview I. .
L]
[Current Project] NewPLCL [Connected PLC] [Current Project] MewPLC1 » wlConnecked PLC]
MewProgram1 (00) @ NewProgram1 (00} MewProgram (00) : Section’ [ WewProgrami (1) - Section (1) |
Sectionl @ Section (1) 00000 |LD W1.0.00 : 000 LD 1 0,00 ;
£ Section (2) 00001 | AND WH0.01 - OO0 | AND 001
00002 | ORVW10.02 n 0002 |ORwW10.02
00003 | ANDNOT Wi10.03 [ ] 00003 | AMDNOT ¥W10.03
(oo [orr v o —
000aY |LD CF113 EIIJEIIJI; LD CF113
QDS |FECALL 815 00007 FBCALL 815
9000 |FB_IMPUT 30 00007 [FE_INPUT &0
.UUDUUB FB_IMNPUT &1 00007 |FB_INPUT &1
4 D0000S [FB_INPUT WA10.02 00007 |FRLINPUT 410,02
.’ 00005 |FE_INPUT &2000 00007 |FEWNPUT 32000
.0 00005 |FE_INPUT &2000 00007 |FEMINPUT 32000
LI 4 _>| .’ 00005 |FE_OUTPUT w1003 Q0007 FB_?UTPUT Wi0.03
farhiEpilpies sl gare of Maved £ .0 00008 |[FB_CUTPUT W10 .05 00007 |FE_OUTPUT W10.06
* 00005 |FBERD 00007 |FREMND
R4 00008 | AN w1002
l YT cocoe oo 0y
*
& —
.0 q allal 1 al
o For Help, press F1 !| Same | Oiff [ Maved
R4 PYd ™
& .
3 PR3
.
You can check ladder contact Lot
. .
.
address differences. o
o*
. .
.
.
. .

In addition, you can check add,
delete, and move contacts, coils, and

apply instructions. 2.24




Start-Up /

Unit

Program

Adjustment On- - Parameter
site Modification Change
Unit Parameter Change and Verification
After modification on-site, you can verify it with the designed Unit parameter and display the
differences graphically. This allows for easier checking of the parts modified on-site.
1. Read the designed program. In this example, read “Samplel”.
Then connect online. (If you have already read it in the previous section’s operation, this is not
required)
Click [I/O Table/Unit Open the I/0 Table/ Unit setting, then double-click the AD Unit.
Settlng] | PLC 10 Table - SewPLC1 =1 CI1W-ADDST W1 [Fdit Par,
[le [de Wew Ootions Heln
® CIMCPULS Dirclayedt Pas et [T T ~ |
¥ gy Inner Boord
Hlm:;;" F.“h | ; nirn |_ _”Hulwnm | unit | -
Double-click the o j
registered AD Unit g Dot e ) :225:: :ZZI: 5!2!3: s mn
0 oy AT
n IngutB Ingut signal s sating

Input! Input range semng
Inputd Nt rangi semng
| Input? Ingut range seling
RS Progem Inputd Input rangs semng
INpUtS INpUt rangh semng

!npu!f !rs-u! range sefing =
Help
=l N
it | =l
; Toarufedlod b P} | Tm:mrr\':muml Comowe . et |
Click [Compare] button suvgass | — % ] oo

2. Click the [Compare] button.
Now you can see the difference between the designed Unit parameters and the configured
parameters in the machine.

Edit Parameters
Edit Parameters
[Eompaiing parametsrs
Fompare unsuccessiul (2 mismatches)

*

’

Click Cloze | You can check the

number of unmatched

items.
3. Unmatched detail differences can also be checked.
Displayed Paramete Bl arameters = ‘ Unmatched items are
s .
ws® e
Itern Setvalug Read vale (Compa] || g u®® o Shown n Orange'
Input! Input signal use setting Enable Disahle a® .0
Input2 Input signal use setting Disable Disahle -
Input3 Input signal use setting Disable Disahle ,‘
Inputd Input signal use setting Disable Disahle .0
Inputd Input signal use setting Disahle Digable *
Inputh Input signal use setting Disahle Digable .’
Input? Input signal use setting Disable Disahle °
Inputd Input signal use setting Disable Disahle .
Input! Input range setting 1-6v/4-20mA +[-10Y *
Input2 Input range setting +-10 10
Input3 Input range setting +H-10W =10y
Inputd Input range setting Rt +-1 0
Inputs Input range setting Rt +-1 0 =
He After checking the
Al Al : ;
unmatched details, Unit
n® H
Lsse®®"" parameters can be easily
glwne® .
-l PPPELL modified.
= st
' TransfeilUnitto PC] | TransferdPC to Unif ! Reset

Set Defaults ok Cancel

You have now completed Chapter 2: Example of PLC System Construction by CX-One.
2-25 The next chapter describes PLC network construction flow.
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Example of PLC Network System Construction by CX-One

Workflow in This Chapter

This chapter describes an example of PLC network System construction from start-up to reassembly and on-site

adjustment as shown below.

This chapter mainly describes how to start up the System using CX-Integrator, an integrated start-up Support

Software for various PLC networks.

Start-Up

Adj. On-site >

[
g ; Controller\ [ CompoWa Saving 1 Equipment System Controller\ [ Checking
StZrl;-CU Dset\g::til}let SNt;rlt_-lPJk Link y System , Disass’y/ } | Config. Link CompoNet
p p P Start-Up /|/F Start-U Config. | Reassy ,” |Verificatio Diagnosis/ | Network
Start-Up Adj. On-site
o Describes details from disassembly of a system for which

e Describes details from assembly and wiring of PLC
System to program download for a trial run.

e Target of Start-Up
Aims at removing the cause of errors from a PLC
and to turn off all of red LEDs that indicate errors for
any component of the PLC System.

e Saving the entire system configuration after
completing start-up is recommended. You can utilize
it for system adjustment on-site after delivery to
reduce the adjustment period.

System Configuration

CJ1W-CLK21-V1
Unit No. =1Hex
Node Address =01
Termination Resistance Setting =OFF

CJ1W-SCU41-vV1

CJ1W-DRM21
Unit No. =OHex
Node Address =01
Other Settings = Default

CX-One

the trial run, delivery, and reassembly on-site as well as
operation check have been completed.
o Target of Adjustment On-site
1) Confirm that no error will occur in its electrical system in
the same system configuration as that before delivery.
2) Confirm that no discrepancy will be found in Controller
Link network settings by connecting to a network on-site.
3) Though CompoNet network is characterized by tool-less
easy start-up, using the tool can shorten the time required to

check the wiring.

CJ1W-DRM21
Unit No. =OHex
Node Address =04

CJIW-CLK21-V1
Unit No. =1Hex
Node Address =02

CJ1W-AD081-V1 Unit No. =3Hex Termination Resistance Setting =OFF
Unit No. =21
CJ1W-DRM21
CJ1W-ID211 CJ1W-CRM21 Unit No. =OHex
Node Address =05
PLC1 !F PLC2 PLC3
CJ Seri PLC\CJ1IM{CPU13 CJ1G- CPU45 CJ1G- CPU45H
" " Tt —  CJIW-CLK21-V1
2 o o Unit No. =1Hex
i o g Node Address =03
Connection Cable 4 [l a0 EIEI STgrmin_a(t)ioNn Resistance
CSIW-CN226 0] 8 4 9 @ & d Eﬂ eting =
(2m) A E5CN-CQ203T-FLK
Unit No. =1

:’cnw-oczn

Connection Cable o
XW2Z-200T CJ1W-NCF71

Unit No. =2Hex |

NS Series PT
NS8-TV00B-V2
System Version

B
Servo Driver
R88D-WNO1L-ML2

| m E5CN-CQ203T-FLK

CompgWay/F Network Unit No. =2

DeviceNet Network
Address = 3

Uselat 125K bits/slzc

[ ke ae e

DeviceNet Network
Address = 4
Usel at 125K bits/sec

6.0 or later +Setting
Routing Table (Local Network Table ) DeviceNet Network | b ‘ ‘ b ‘
IoReey Wofel  Iorew  [oma
nit No.
Address Uselat 125K bits/sgc
1 1 ‘ CompoNet Network Communications Mode No. 1
2 2 [T] | [T] |
Note) The Local Network Table is required in order to I/0 Relay 1/0 Relay " - _-__, —
Terminal Terminal Word Slave Word Slave

3-1 attach more than one network communications Units.
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Start-Up Config. i 4 Verification & Diagnosis

PLC Network Start-Up

Online Connection to PLC (Automatic Online Connection)

1. From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Integrator] > [CX-
Integrator] to start CX-Integrator. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-
Integrator] > [CX-Integrator])
Starting CX-Integrator

alln =
e G e et et (owmest fem gedes e
DRd @R o aNAGad = 3|5
L Afsisiea*BANSFLLAR T &
B
o 3]

e

CX-Integrator starts and automatically connects online.

asert  Metwork Component Tools Windows Help

Click % @4*.@3@{““%&|!@E

FENEpadde>BE 2O E

~=

Auto Dnline x|

W[

Goes onlne autematically
Select connection type and press [Connect] button.

Select a serial port.
When USB conversion

(Important)
This operation is used for online

i~ Connection typ:

cable (CS1W-CIF31) is
used for connection,
specify the COM port
number of the USB
port used.

Select a serial port,
then click [Connect]

NN NS NN NN NN NSNS NGRS EEEEEEEEEEE II Cancel

1+ Serial connection(alsa when using USB-Serial conversion cable]

connection to any PLC hereinafter.

uw o ZEERORCPT Unless described otherwise, use
COM1 hd

this operation to connect online.

" USB connection

Connection will automatically be made to the PLC connected directly to the
P via serial cable

Itis not possible to automatically connect to a CompotWay/F component,
“Supported PLC: C5/CI/MSJ series

ATude~WAESELLAT

=s=== Al communications Units and ports of
a connected PLC are automatically
displayed in the online connection

J

information window.
3-2
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Checking PLC Error

C¥-Integrator

Errors are inspected in the target PLC.
Please check the content of the errors by "Display E&sror Log" befare executing Online functions.

(1) Remove the cause of the PLC error, then make it available to run.

J 3] Met[0], Node{0]
Move the cursor on the

PLC and right-click

Start Routing Table

Select [Error Log]

(2) Check the PLC error.
Examples of 10 settings error and CPU Bus Units and Special I/O Units number overlap error
are shown below.

Ew PLC Errors [_]]
File Options Help
Enors | Eror Log | Messages| You can check an error in a CPU
len [ Cote [ Slaus [ Delals 1 Unit and error history.
gg; D.x??EEI E:::: ‘Uong;g\nag:lér.rfal:lumberDupl\catlon Err.. (YOU can Use the same funCtlon |n
the error history of CX-Programmer’s
online screen)
|CaM-CPULE  [Run |Clock: Mot Monitoring

=

(3) Solve the cause of error.

You must solve the problem through the following procedure:
- Set the PLC to PROGRAM mode (in which you can change settings).
- Change the rotary switch of the CPU Bus Units and Special I/O Units (make sure
that it does not overlap).
- Create the 1/O Table.

¢ Set the PLC to PROGRAM mode.
From step (1) above, select [Mode Setting] then [Program] mode, and click the [Set] button.

L]

2| =3 Orline Toolbus COM1,9600,Mane.8,1 [CITM-CPU13] Neti0), Node()
[ER==k T oiget PLC [C1H-CPUT 3] Neti], Node(O
-ofg, CPU Port [CIM-CPUT 10 table

Error Log

Start Routing Table

PLC Mode Sektin:
TSl atoe
MNode Address: 0 CHM-CPU13
Please confirm there is no problem even if stopping PLC execution, Is it O to change to
StopfProgram Mode?

i~ Run Set

" Monitor

) Debug Fead

d

Online Status: .

* Click [Yes].

|M0de Command haz been completed.

LCloze




; 1 \
ICAMGAI  PLc Y Devicenet Y nTLink Y “OTel" Ncompoway Y S3ine Y
Start-Up Start-Up Start-Up Start-Up Start-Up /F Start-Up Config. A J

Controller
Link
Diagnosis

System
Config.
Verification

¢ To change the Unit number change the rotary switch of CPU Bus Units and Special I/O Units

and restart power O

SCU21-V1
RUN ERC SD1 RD1
o o @ o

a o a
RDY ERH SD2 _Eg

e Check if any error occurs in the PLC (CPU Bus Units and Special I/0 Units number overlap

error should be solved).
_I - Online Taolbus COM1.3E00 Hone, 2.1 [mM CPLI3] Het(0], Nodef0)
A-C|

10 tab\e

-.f.- CPU Pur [CJWM CPU1

Start Routing Table

e Create the I/O Table.

x| {8 Oriine Toolbus COM1.8600 Hone 8.1 [CL1ht- EF’LI13]Nat[D] Node{0]
" Tl Tlo

[ CJTM-CPU1 3] Net ], Node
-,f, TP Port £ [CTh- cpmw

Mode Setting

Start Routing Table

Edit View | Options Help

Fu PLC Errors
File Options Help

P S

Erors | Emor Log| Messages |

k=i [ Code [ Status

[ Details [

0x80ED

]

Fatal

1T Setting Enron

|cnm-crulz  [Run

|Clack: Mot Monitoring

T § PLCIO Table
File Edit Wew Options Help

=] E3

@ CIIM-CPU13

g, Inner Board

g, [0000] Main Rack
&y, [0000] Rack 01

=
&g, Inner Bo.
-, [0000]M

Transfer to PLC
Transer from the PLC

Compare with PLC
a, [0000]R

Werify

Delete

Hot. Swap

RackiSlot Start Addresses
Units Prafile information

Dip Switch Information
Change ETEL Mode
Copsumption and Width

Start Special Application  »
Cormpare with Braject
Check

Create Registe[CJIM-CPUIZ  [Program v

|
T § PLC IO Table [_[O]

Fle Edit Wew Options Help

g, Inner Board

=44 [0000] Main Rack
-1] 00 [0000] CILW-ID211(DC Inpuk Uity
5l 01 [0001] CILW-OC21 1{Relay Output Uit
-4l D2 [2210] CILW-ADOBL-V1{Analog Input LY
5] 03 [1550] CILW-NCF71(Position Contral L
-4] 04 [1500] CILW-DRM21(Devicehst Maste|
5] 05 [1525] CILw-CLK21{Controller Link Unit
-4l 06 [1575] CILW-5CU41-V1(Serial Commun
5 07 [0002] Empty Slot
-§ 08 [0002] Empty Slot
5 09 [0002] Empty Slot

4y, [0002] Rack 01

< »
ICIIM-CPUL3  [Program 4

e Check if any error occurs in the PLC
(all errors should be solved).

| =/ Online Tookbus COM1,3600 Hone.6.1 [CJ1M-CPU13] Net(D), Hode(0)
=] bzl T et PLC ()1 MACPL 1 3] Nel0] Nodsiol
<<% CPU Port [CJ1M-CPLT

IO table

Start Routing Table

L5 - L

[e3m-cPULE  [Run 4

PLC ID Table [ <]

& Are you sUre you wank ta creake the 10 Table 7

PLC ID Table [ <]

& Tnitialise CPU Bus settings ?

Py

s
“ay, .

.

Click [Yes].

Transfering...

| ]

The I/O Table is created and
Unit configuration is displayed.

=

Bo Qphiors  Help

Emors | Enn Log | Mesenges |

[Code [ | Deins

Rern
Tio Enees

(=]
iEiock: ok Monkorng.

3-4

EHMFLS Frooram




PLC Network - q Controller Saving . N System Controller
SV (7., Boeet | AT Y ik T Gemoar Y Sysem | Conig. Lk
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Confirming the Routing Table is not Configured
Re-connect to a PLC (1) Check that Routing Table is not configured.
with CX-Integrator _| =- E, Online Toolbus CORM1,3600,None,8.1 [CI1M-CPUT3] Net(0], Mode(0]
E@ Target PLC [CJ18-CPU13] Neti0], Node(0]

=5 CPU Port [CJ1M-CPUT3I[Net(]. Ndel] Unitl) g

2 DeviceNet [CHW-DRMZTTIEN2), Node( 1] AR sz Check Routing Table

25 Controler Link [CTw-CLK21] Net( 1], Nogel ] Uii(1) presence. If the Routing Table

“ogln SCU Port [CHw-SCU41 %1] NS Model-, Unit3) is not configured, create one.

a

=

2) Conflgure the Routing Table.

Met(). Node(0)
Move the cursor on the === ST

PLC and right-click

L L
Error Log
Maode Setting

Dd;3[1 1. Unit{d]
Mode[1], Unit(1]
odel-], Unit[3]

Select E
[Start Routing Table] CETERT PP FPPEREIFRIRE . Start Routing Table

1 PLC Routing Table [_ O[]

Fie Edit Cptions Help

MEEE R E N

g CIM-CFUIS = -
F)-tagy Uit 00
Unit 01
~umtD2 oz
Unit 03
Unit 04
Unit 05
Unit 06
Unit 07 Hede

w
=
)
S
-
@
@
=

112[13]14|15

Unit 03
Unit 09
Unit 10
Unit 11
Unit 12
gy Unit 13
g, Unit 14

). LI} 15 = =
4|+ m[ » 4] | »

~ siou [Tz " MainVie [ Dverview | Tableview |

[cim-cPu1a |Netwark: Mode:0 [Program 2

=

(3) Edit the Routing Table and transfer to [PLC].

Right-click and select local

network (Unit) [Insert CPU R
SIOU] or local network (port) Insert CPU SIOL —— F =
[Insert EORT] Inserkt EORT Local Metwork. Mumber _|:l

]

Set the Routing Table as shown below:
¢ Assign a network number to a Unit number.
Enter its local network e A Unit number can be checked on the online information window.
number, then click [OK] « Assign a network number to each network.
The Controller Link network number is same for other PLCs.

(4) Check if the error is solved.
¢ Re-connect to the PLC.
e All errors should be solved and no error messages should be displayed.
e The network number is displayed on the communications Unit.

Reconnecting CX-Integrator

3-5



PLC Network PLC
Start-Up Start-Up

Right-click a DeviceNet
Unit under Target PLC in
the online connection
information window, then
select [Connect]

; q Controller SEW) ' o System Controller
DeviceNet NT Link L CompoWay Syster% ' \ C)clmfig. L
Start-Up Start-Up Start-Up [F Start-Up Config. A% ," Verification 4] Diagnosis

DeviceNet Start-Up

Remove DeviceNet communications errors and establish communications.
= Check DeviceNet Unit's 7SEG indication and ON state of MS/NS LED.
= Check Slave Unit configuration trough CX-Integrator.

Create a scan list of DeviceNet and determine the memory map.

(1) Connect to PLC online, then connect to DeviceNet through the online connection information
window.

Shart Bata Link
Skart Routing Table

=

(2) Next, upload the network configuration information of DeviceNet.

x| = . Online Toolbuz EDM'I 9600, Mone 8.7 [CITM-CPUT3E] Net[0], Hode(0]
T = @ Target PLC

- Unit{1]
i3]

—-f-— EontmllerL
-fj SCU Port [0

Conneck

Shatt Data Link
Skart Rouking Table

Nebwork structureffetwark Mo.:2) will be tranferred.

& Plese transfer the netwark parameter for each companent i nesded becauss they are not transfered here fin the
case of Contraller Link and SYSMAC LIMK).

In this example, although one Master Unit (hode number #01) and two Slave Units

(node number #02, #03) are actually connected, assume in this start-up example that

one Slave Unit (#03) is not connected due to disconnection.

Do you wish to continus?

(3) After transfer is confirmed, connected devices on the current DeviceNet network are
displayed as shown below.

# #02
CJTW-DRMZ2T  DRT2-IDT6+RW..

e | »

"~.,‘ Check if a Slave device on the remote 1/0O
communications actually wired is
recognized. Master Unit (#01) and Slave
Unit (#02) are recognized, while another
Slave Unit (03) is not recognized.

3-6



PLC Network
Start-Up

PLC
Start-Up

Right-click on the Master
Unit icon and select
[Monitor] to display the
device monitor screen.
Select [Status] tab

Perform the step (2) from
the previous page

Double-click a Master Unit
(CJ1W-DRMZ21) icon

{

Click twice

{t

Click the [OK] BULOM ... -y s, svv s

Right-click the Master Unit
and select [Parameters] >
[Edit]

{

Edit the parameters, then
click the [OK] button

Select [Network] >
[Transfer [PC to Network]]

QI [7 Auto skoc stion &t i regiitersd
La._l

a

L

".... - ene e
"

; q Controller SEW) ' N System Controller
DeviceNet NT Link L CompoWay Syster% ' \ C)c/)nfig. L
ST SN Start-Up i siar=Ul Config. A% 2 Verification 4| Diagnosis

T | Lk Vo | Dot i i Tiws | s My |

(4) Check the error on the device monitor screen.

Slawe Statuz —E’.
*

COQACTE ..
0001 02030405k
Lt e Tt e T e P T

[T
P

5
£

2 twsiage Commr s Pemed I

You can check the Slave status on r
the device monitor screen as well.

Slave Unit (#02) is recognized, while the
other Slave Unit (03) is not recognized.

—
=t
-l
=
r

(5) Wire Slave Unit (#03) correctly.

(6) Re-upload the network configuration information of DeviceNet.
!IEI

. Metwork 1{DeviceNet){ #002)

Now it can be confirmed that Slave
devices on the remote I/O

#03 communications have been recognized
CI1W-DRM21 DRTZ-ID16+AW, ., DRTZ-OD1E+E, ., . .
and communications have been
established.

(7) Configure DeviceNet remote I/O communications (free assignment) and register the Slave
to the Master.

v pece Pramercr &
Commurication Cpcle Tme | MessapeTimee || SlaveFurction | Commuicaion Cycke Tave | Mesrage Tiom | StaveFurtion |
Beoonl | D decaoOlT) | 10 AocalrilN] Brnesd v 1| i |
Urvegitaer Disvice Lt Urvegither Dievice List
B | Produci Hame [OuiSiee [ntiee | B | Produt Hame [Ousee [insee |
e DRTADEW D16 U ABe
103 DRTZODIGWTODE ABwe  Dbpe

Two Slaves are now registered to th
Master.

(]

W | T | Autn alooshon . moueed
Reistes Dimiion List — 8

W | Podue | DnSie |OwCh |inSes |mch | C [

O PP PP e p————
fonz DATZ. OBpe dBde  TH0EL.
P03 DRTZ. 4bpe W000L. 0 Dye
I ek | Adverced Sohp nm..m.uwi
Wsdoad Rormioad Lompae
llllllllllllllllllllllllll ---J---ll-l J

(8) Configure assignment of Slaves to areas of a CPU Unit.
If necessary, configure the Slave parameters as well.

Commneahon Cpcle Tem | Slwvm Furcton |

1 Allecationfil)

Mezsagm Temn |

Gereral LD Ao ationdDUIT] |

<Master Unit parameter edit dialog box>

Memeny Block 1
h | Prockact N [ = h
W o000k00  m0IDATZ
W J200:0#00 00 DAT2
W 2010600 =0IDAT2
W 2010600 =03 DAT2
W 02900
LR i)
W 203000
L i)
L et Eif)

L= ll
i

Sae

Setgp.
el ) B

l.....

(9) Start remote 1/O communication.
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NT Link Start-Up

Remove NT Link communication errors and establish communications.
= Release NS Connecting . . . message.
= Check NS configuration through CX-Integrator.

(1) Connect to PLC online, then connect to a CPU Unit through the online connection
information window.

x| E@, Online Toolbus COM1,9600 Nane 8.1 [C11M-CPUT3] Net[0], Node(0]

Al EI@ T

el-], Urit-]
. Mode(1], Unit{0]
1], Mode(1], Unit[1]
1. Mode(-], Unit[3)

Right-click a CPU Unit
under a connection target

PLC in the online Shart Data Link
connection information Start Routing Table
window, then select T Link Toal .
[Connect] Zontroller Link Tool 4

=

(2) Select in the order from upper link port to NT link.

CX-Integrator CX-Integrator
Selected [tem  CPU Port[252) : Serial Port Selected Jtem  MTLink
Select the item from the fallowing list. Select the item fram the following list.

| EomEoWaiF

Cancel

=) e

=
<

(3) Next, select [NT Link Tool] > [NTLink Auto Online Setting] from the CPU Unit.
= =
4

Nnde[ 1. Unit[0]
1]. Mode(1]. Unit(1)
. Wode(-). Urit[3)

----- Transfer[Metwork to PC]

_____ i Canneck:

Stark Data Link
Start Routing Table

MT Link Tool MTLink Auta Online Setting
Controller Link Tool »

<

| ¥

Automatic NT Link connection function is used to automatically connect NS series PT
and PLC via serial connection (NT Link). Connection is automatically performed by
overwriting the PLC serial communication port settings by adjusting to NS series PT

settings.
, 3-8
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PNV sciUp 4 StarUp 4 Serilp 4 oHK JUEStmup Sstem 4 g Config. 4 Link
Start-Up Config. i %4 Verification & Diagnosis

Cx-Integrator
& Changes CPU the setting of RS-232C Port and then connects ta M5 series PT,
Scans the Port Setting automatically until finding NS series PT.

If executing this procedure then CPU RS5-232C Port setting is overwritten,
Ensure that it is not connecting with this part then execute it

Present setting: NT Link, Standard

ArE wou sure?

Click [OK] .....................@
< _5=

(4) Check the CPU DIP switch.
¢ Follow the on screen instructions to change the DIP switch.

CX-Integrator

® Start communicating with WT series PT to analize the setting aukbomatically.

Ensure that Dip Switch 5 of CPU unit is OFF,
It is the setting ko change from RS-232C Pork bo MT Link.,

CI|Ck[OK] EEEEEEEEEEEEEEEEEEEE oz

=

(5) Screen message Connecting . . . is now cleared.

(6) Next, upload the network configuration information of NT Link.

2| == Orline Toolbus COM1,9500 Mone 8.1 [CITM-CPUT3] Met(0], Node(0)

T =
Select _
[Transfer [Network to PC]] ‘=====f==="" Node(1]. Unit0)
1], Mode(1], Unit1]
Connect ). Model-], Unit{3]
Start Data Link
Start Routing Table
MT Link Toal »
Zonkroller Link Tool 4
4| |+l
CX-Integrator

Metwork structureiMetwark Mo.: None) will be tranferred.
Flease transfer the netwark parameter for each component if needed because they are not transfered here {in the
case of Controller Link and SYSMAC LINK),

Do wou wish ko continue?

C||Ck[Yes] EEEEEEEEEEEEEEEEEEEEEEEEEEEE

(7) After the transfer is confirmed, connected devices on the current NT Link network are
displayed as shown below.

= Networkl_CPU Port_Serial Port{NTLink){-} [_ O]
Metwork1_CPU Paort_Serial Port[MTLink] -
Compal Cenipe
ﬂl 1)
=5 -
NSE-TYO0- 1
CIAM-CRUT3 i
[ J {=]
=l




PLC Network
Start-Up

Right-click a Controller
Link Unit in the online
connection information
window, then select
[Connect]

Select

[Transfer [Network to PC]] === =« sssaasssanrsas

Cllck[Transfer] IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII‘ Tranzher

PLC
Start-Up

: G 5
DeviceNet NT Link Controller CompoWay Saving i N| System Controller
StartUp 4 Start-Up Bink JF Start-Up 4 System 4 iy Config. Link

Start-Up Config. i %4 Verification & Diagnosis

Controller Link Start-Up

Remove Controller Link communications errors and establish communications.
= ON state of Controller Link Master Unit's INS LED
= Check Controller Link configuration through CX-Integrator.

(1) Connectto PLC online, then connect to Controller Link Unit through the online connection
information window.

=k g Online Toolbus COMI 9600 MNone,8.1 [CJTM-CPUT 3] Met(0], Mode(0]

I W coal 7 et PLC [CJ1M-CPUA 3] Net(0), Node(0)

----- -_rfa CPU Part(Serial Port:MTLink[CJTR-CPUT3] Met(-], Modef-]. Urnit{252]
----- -.1'.- DeviceMet [C11w-DRM21] Net[2] Nude['l] Ll rit{0]
----- pren Contraller Link [ 1% I e[1] |
..... = SCU Pot [T Transfer[Netwark b PC]

=

(2) Next, upload the Controller Link network configuration information.

Conneck

Skark Mok Linl

= =m0 Orline Toalbus COM1,9500 Hane 8.1 [CJ18-CPUT3] Met0], Node(0]
2l El@ Target PLC [CI10-CPUT3] Net0), Nade(0)
----- = CPU Part [CITM-CPU13] Het[], Nodef-], Unit(-)

----- —ij DeviceMet [CITW-DRM21] Met(2]. Ncu:le[1] LInlt[EI]
----- -E]JQ Contraller Link [2J1% [

Conneck

Skark Miaka il

Tranzfer[Metwork [#001) to PC] |

Fleaze zelect the tranztered data, and press [Transfer] button,

© Metwork structure only

% Metwork structure and Parameters for each component

Fleasze transfer the netwark parameter for each component if
needed because they are not tranzfered here [in the caze of
Cantraller Link and SYSMAC LIME).

Cancel

=
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PLC Network
Start-Up

Select

[Transfer [Network to PC]]

Click [Transfer] SN NN EEEEEEEEEEEEEEEEEEEEEESE I

-
: i .

PLC DeviceNet { NT Link COE;;(I)(”er CompoWay SS)?thQ% ! | g)c’)sr:f?a" COEit;?("er
S SENHL SN Start-Up i siar=Ul Config. A% ," Verification 4] Diagnosis

(3) After the transfer is confirmed, connected devices on the current Controller Link network are
displayed as shown below.

- Network2{ControllerLink){#001)

M=l B3
Netveork2[Controller Link] (HOO01] -
Compod Compaod
CJ1M-CPU1S CJ1G-CPU4SH
HOO1 HO02
P ! 4
hd

In this example, although three PLCs are actually connected through the Controller Link,
in this start-up example explanation assume that only two PLCs are displayed.
(One PLC did not join the communications due to incorrect Routing Table settings)

=

(4) Check the Routing Table and configure it correctly.
See “Confirming the Routing Table is not Configured” for configuration details.
(5) Re-upload the Controller Link network configuration information.

:II E- . Online Toolbus COR1T,9600,Maone, 8,1 [CITM-CPIUT3] Het{0], Hode(0)
g - 3] Met[0], Mods(0]

% OR3Pt ¥

Canneck

CTk=wk Mizks Linl:

=

Transfer[Network(#001] to PC] %]

Flease select the kransfemed data, and press [Transfer] button.

€ Metwark structure only

% Metwork structure and Parameters for each component

Flease transfer the netwark. parameter for each component if
needed becauze they are not transfered here [in the caze of
Controller Link and SvSMAC LINE).

Cancel

=

(6) Send the network configuration from the network to the personal computer.

= NetworkZ{ControllerLink){#001) [_ [0}
MNetwark2 [Controller Link] (RO071)

Compod

L

Compiod CompoS
CIM-CPU13 CJ1G-CPU4SH CJ1G-CPU45H
#001 HOO2 HOO3

| |

3-11




PLC Network
Start-Up

PLC
Start-Up

Right-click an SCU port in
the online connection
information window, then
select [Connect]

((d

Select SCU port (140)

(il

Select CompoWay/F

Right-click an SCU port in
the online connection
information window, then
select [Transfer [Network
to PC]]

{t

Click [Yes] in the message
dialog box

{t

Select [Selection], enter
1 for minimum and 2 for
maximum values, then
click the [OK] button

: 1
DeviceNet NT Link COEit;?("er CompoWay SS;SVtIQ,% :
Start-Up  4i StartUp 4 oo yp 4 /F Start-Up 41 ot A

CompoWay/F Start-Up

Controller
Link
Diagnosis

System
Config.
Verification

Remove CompoWay/F communications errors and establish communications.

= Check CompoWay/F configuration through CX-Integrator.

= Configure serial communications Unit parameters.
= Configure temperature controller communications.

This example explains the start-up of a serial communications Unit with two temperature

controllers (E5CN) connected via CompoWay/F.

* Two temperature controllers (ESCN) are connected to serial communications Unit
(CS1W-SCU41-V1) port no. 1 via RS485. Communication Unit numbers are #001 and #002.
e Communication settings of the serial communications Unit and the two temperature controllers are

unmatched.

e« Communication settings between the two temperature controllers are unmatched as well.

(1) Connect to PLC online, then connect to a CPU Unit through the online connection

information window.
_| =- . Orline Toolbus CDM‘I QBDD None 8 CJ1-CPU13] Met(0). Mode(d)

TransFer[Network ko PC]

E—
=

CX-Integrator

Selected ltern  SCU Port(140): PORT1

Select the item from the following list.

' Ok I . Cancel |

Py
i

CX-Integrator E

Selected ltem  Compo'w ayF

Select the item from the following list.

*

Cancel |
=

L]

L]

(2) Upload the CompoWay/F network configuration information.

2| = Orline Toolbus CDM‘I SBDD None 8.1 [CITM-CPUT 3] Met(0), Node(0)

—ij EPU Port [E;J1M EPU13] Net[] Node[] Urit(-]

-.f.- DeviceMet [CI1W-DRM21] Met[2], Made(1], Unit{0]

T Eontroller Link. [CJ1W ELK21]Net[1] Node[1] Unit[1]
[FOR

Trans| tr:e

Conneck

=

Cx-Integrator [<]

Metwork structure(Network No.: Mone) wil be tranferred.
Please transfer the network parameter for each companent iF needed because they are naot transfered here {in the

case of Controller Link and SYSMAC LINK).

Do you wish ko continus?

Compoway/F Finding node se...[E3

Select finding node range.

 Al[0-39)

& Selection
Min |-|_ I ax Iz
It will take bwo zeconds or less per
?%

Cancel |

Click O 3-12



PLC Network PLC DeviceNet § NT Link § Controller
Start-Up Start-Up Start-Up Start-Up Start-Up
Click [O K] & Cannat aguire the Slave node.

--.....
L]

LIy
LF
LIy
L]

Then click the [OK] button

In the dlalog bOX |ndlcat|ng ..-llllllllllllllllllllllllllllllll

Controller
Link
Diagnosis

Saving
System
Config.

System
Config.
Verification

CompoWay
[/F Start-Up

This dialog box is displayed because communication is
not established between the serial communications
Unit and temperature controllers.

CX-Integrator E
)

The parameters were transferred

completion of transmission

=

Right-click a Target PLC in |

the online connection @) e Addess: 0 EIIMCPUTS
information window, then pe—~ =) © |
select [Mode Setting]. oo * U o horkor Dot
o Monkor € Debu Ee
(a) Select [Program] for A e |
. Online Status:
Operatlon mOde |Mode Cammand has been completed.
(b) Click [Set] ) (c)
(c) Click [Close] after

changing

= NetworkZ_Unit(3)_PORT1(CompoWayF){-)

Metwork2_Unit[3]_PORT1[CompoWayF]

Compod

CHM-CPUTS

Place the cursor on CJ1M-
CPU in the [Network
Structure] window and

. s —— H
double-click g
£ 3IW SE1041-¥1 [View Paranscters] |
I:j istaes Pty [T TP -
_gun®® ———
From the [Display o T ——— :l
_lel Horial cOnmUnG 8GN Moda I Linki{datauity
Parameter] pull-down menu, RN
Se|eCt [Portl Senal ::ﬂl: ;:L’:ulr uiDE00bos)
Gateway Settings] T o o R
Pot: CTS confrol L] |
[Poet1 1. 1 protacal safing |1 pretacal
Pori1: Host Link compatible device mod DefayltMode &)
Port: Host Link unit numser |
_Pnr“ No-Probod ol SEait coos _II
fu-!! .N’J E-um:olgvln.rudr 5 9 =]
Help
= ' ﬂ
i | =l
Toorufellnit toPE] | TransiePCiolind] | Comowe | Beiat
. . . Sied gl I _-_ Lancel
Click [OK] in the [Edit
Parameters] dialog box and
close the dialog box \
Select a poit to reset from the list below
Select

L4

[HOSTLINK1]
and click [OK]
button.

.
.
‘e

L

‘e
it YOO

Perform the step (2) in the
previous page

Click [OK] button in a dialog from the previous page.

box indicating completion of
transmission

3-13

~=

window, as shown on the next page.

(3) Adjust the serial communications board parameters settings to those of the CompoWay/F.

The [Network Structure] window
shows a CPU Unit (CJ1IM-CPU13)
that has a serial communications

,+** Unit, but neither of the two

temperature controllers.

Configure [Portl: Port settings] to [Manual]
and [Portl: Serial communications mode] to
[Serial Gateway]. Check other settings as
well, and change if necessary.

)
0
0l
Chpptaspec Parameter | Fort]. S misl Gateway Setings =]
n
i T

Portl: Port seftings
Foet’ Sanal cammunicasons moda |
{Port1. Dala lungth [
Forti: Giop bite

[Podt: Pary

Forll. Daud rale

Fortl: Sand delay

Por1. Bund deliny (user speciied)
Portl: CTS contral

Foet” Ganial Gateway Responss imas |0
L’Pu-n Surial Galvway send slar bmeou|0

Click the reset button to
enable settings. Click [OK]
in the reset confirmation
message dialog box.

Ciemvr] ) ;

Sl Dighaile

=l

»

_ x| e |

Confirm that settings are correct, then select the
[Transfer [PC to Unit]] button. Click [OK] in the
transmission confirmation message dialog box.

Edit Parameters x|
.
\!J) The unit was restarted,

Click

(4) Re-upload the network configuration information of CompoWay/F. Perform the step (2)

Only the Units for which connection is established are displayed in the [Network Structure]



. V 5
PLC Network PLC DeviceNet NT Link COE};?("er CompoWay SS;S\{[Q% ' S gﬁ:ﬁ;ﬂ COE};?("er
Start-Up Start-Up Start-Up Start-Up Start-Up [F Start-Up Config. A4 ," Verification /] Diagnosis
. Networkl_Unit(3)_PORT1({CompoWayF){-) |_ (O] x|
ek k) PERTICamees - The [Network Structure] window
Compot shows only the Units for which
m .ussssss=sss==ss=ps== cONNection is established, and Units
with incorrect communications
CJIM-CPU13 . .
setting are not displayed.
=, N 1
=]
Check the temperature (5) Check the §ettings of the temperature contro[ler th'at is not displayed in the. [Network
e [y Structure] window (baud rate, data length, stop bit, parity, Unit number), configure it correctly,
di then re-upload (Perform step (2) from two pages ago). The [Network Structure] window is
isplayed properly and updated
conflgure it correctly — Networkl_Unit(3)_PORT1{CompoWayF){-) H=] E3
Ij Network1_Urit[3)_PORT1[Compo¥ayF) -
|:j Bompot J Now the correctly configured Unit is
m displayed and you can confirm that
communications settings are correct.
Perform step (2) from two BIHEEE 9
pages ago
[+
]

{
!

(6) Move the cursor on E5CN of communications Unit number #002, then select [Start Special
Application] > [Start with Setting Inherited].

= Networkl_Unit(3)_PORT1{CompoWayF)(-) 1=l B3
Metwork1_Unit[3)_PORT1[Compa¥ayF) j‘
Compo2 " e
Compo
m 8 -8
Parameter
CJTM-CPUA3 ESCH ESCH —
. . #001 o M2
Right-click on the . l | - Toggle Postion
. . . X B2 co ChrHE
communications Unit o
R Paste ey,

number #002 icon in the
[Network Structure] window,
then select [Start Special
Application] > [Start with
Setting Inherited]

LY Delete

Edit Mame. ..
Edit Mode Address

(6) Dedicated Support Software CX-Thermo is started with the same model and setting as
that of the temperature controller.
After parameter settings are finished, download the settings to the E5SCN of
communications Unit number #002.

. - Thermo [ ]=]
After parameter settlngs FlD) Commsmaseni) Vedl) Tt Oplenit) Hbitd
are finished, select IEETENI it S
. . o [0 Tl e= Charend -1
[Communications] > GHL_ e Puanctetons ek Port
[Download to Device], then e i
select either [Download all], = 3 o O
&5 Cooninpapess Puomcion o || ks e Updwell
[Download Changed JTFS%D -
Parameters], or [Download ﬂ':m;ml o S
o UpparLind Ve
Changed from Default] i o f
%EL:}: T eseet|
gmfxtz::; 56t the saqured teripe shaei e on]
-2 Adttmant vel
5P
B =
DLR1G5 12 4431 [sdca] w anched ficas T Indegaton m the On koe ftate. ﬁ
12005 12:44:81) The setting of e5en-BT beging
[“unficmang Le connestan
. ing eckited *is HOT 10 “corzected Device” J
[l_ll()!l)\!!44';[_5Th-xl:u“n:!r'h:an}J}E.Flli by :!
Uit ndeflLZ) Com e 3_14
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Saving System Configuration (1)

Save the system configuration for inspection after delivery.

(1) Connect online to a PLC on a network.
The online connection information window is displayed.

| -/ Oriine Tookbus COM1 3600 None8.1 (CITM-CPUT3] et Nodel0)

e e : All communications Units and ports of
Ey | Nodsf-, Lirit ==== g connected PLC are automatically
DeviceMet [C14wW-DRM21] Net(2), Node{1), Unitid) : : : :
;‘@ Contraller Link [CITW-CLE21] Net[1], Node(1], Unit[1] qlsplaye_d n the Onllne Conne_Ctlo_n
el SEU Port [CJ1%-50U41441] Netl-], Nodef-), Unit(3) information window. From this window,

connect to each network and save the

’ configuration to a project file.

(2) Send the network Structure of DeviceNet to the personal computer.
Connect to DeviceNet from the online connection information window. After connection
is established, send the network Structure of DeviceNet to the personal computer.

x| = [, Oriine Toolbus COM1,3500 Nore.8,1 [CI1M- EPLHE]Nat[D] Node(0)]
JET = < xe] 7 21t PLC [CJ1M-CPLI13] el

Move the cursor on the
DeviceNet and right-click

j B[ Orline Toolbus EDM1 EISUD No 8.1 [CJIM- EF’U13] Net(0], Nods(0)
R 15 MO [

Select [Connect]  wuuunual....

Select y e
[Transfer [Networkto PC]]""""""""'"'""""'"'""""""'"'"""""""""""“

ot ko oLl

(3) Send the network configuration of NT Link to the personal computer.
I:j Select the connection menu on the CPU port, then select upper link port and NT Link.
I:j Next, select the transmission menu on the CPU port.

2| 5[ Orline T ulhus COM1,9600 Hone.8,1 [CJ1M-CPUT3] Net(d), Hode(0)

T =W oo

Transfer[fetwork ko PC]

;f-— Cantroller Link [CHW CLK21]Nelf1] Moc
L RS AA A Y A

I
ZEarE Data Lk
Se|eCt Start Routing Table

Select [Connect] ==ssssasagas

) Contraller Link [C‘HW CLK21]Nel[1] Ma

2 SCU Port [STW S Netl . Node , @30MeCt

.®
Py Start: Data Link:
.

B o* Skark Routing Table
[Transfer [Networkto pc]]--------------------------------ﬁ sssdEsesEnnEEEEEEREEEREES —
SeleCt Selected | CPU Port{252) : Serial Py Selected | NTLink.

q q ted It 1252): t ted It
[Serial Port] > [NT Link] sssssssssssssssssssannns i o e seeeEn TN

Select the item from the following list.

Select the item from the following list.

Cornpol ayF
CPU Part[253] : Peripheral Port

Cancel Cancel |

lj \ S
—J

(4) Send the Controller Link network configuration to the personal computer.

Connect to the Controller Link network. After connection is established, send the network
configuration to the personal computer.

= Online Toolbus CDM1 EIEDD MNone 8.1 [CJ1M CPUT3] Net(0), Mode(0] x| =3 Oniine Too\bug EUMT,BEUU,N
=S ME Mode(0) JET = @ 3
I@ EPU Pnrt[SenaI PnrtNT DHM -CPUA3] Net(-). Model-), Urit(252]
g DewceNel [CITw-DAMZ21] Hetf2), Node[1] Umt[D]

I;Iﬁ

81 [E,JTM CPU13] Met(0], Node(D]

. Cont J 1] Ry
-vf-—S F'Url[EJTW U4‘\ 1] Met[-). Nod
Select [Connect] ssssssssjpasasssssssannnsasnnnnnns

Select
[Transfer [Network t0 PC]] auusssssssansssssssaasnnssnsnnnnsnannnnnnnnnnnsnnnnnnnnnnnnnnnnnnnnnnnas®
3-15
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SR S SENHL SN Start-Up i siar=Ul Config. : ," Verification 4| Diagnosis
Saving System Configuration (2)
(5) Connectto a PLC on the Controller Link network.
Select a remote PLC on the Controller Link network configuration screen (a PLC without a
square symbol) to switch the connection destination to the PLC.
Destination PLC communication device configuration is displayed in the online connection
information window.
Hetwark3[Cantroller Link) (#001] . . . - A Green frame iS dlsplayed on
e . Famess | the specified remote PLC.
E o ﬁ Parameter
CAM-CPUTE e - =p-n=rodllag . Network3(ControllerLink)(#001)
001 Status/Error of Communication Linit Netvrork3|Controller k)0 ]
Error Log of Communication Unik Compo3 Compos J
Select [Change g f
connection to this PLC] ﬁ m
CHM-CPU13 CJ1G-CPU4SH
#0017 L Hill d HO03
=]
g q 3 x| =- 1.3] Met(0). Node[D
All communications Units and :ll = % = Tl k(0
ports are also d|sp|ayed in the ,“\ EF'LI Port [CJ16G- EPLIdEH]NeI[] Mode[-], Unitf-]
. K . . DeviceMet [CIW-DRM21] Met(2). Node(5). Unit0]
online connection information ;ﬁ Controller Link [CI14/-CLK21] Net(1), Node(2), Urit(1)
window.

(6) Send the DeviceNet network configuration on the remote PLC.

Connect to DeviceNet from the online connection information window and send the
network configuration to the personal computer.

_I - Orline Too\bus CDM1 SBUU Nane, 81 [CJ1M P1I13] NetD], Mode(O) =[] Orline Taokus COK1SE00,More 6.1 [C11M-CPLT3] He ), Hode(T)
) 2 ] )

EE Targat PLE [CJ16-CPU45H] Net{1), No

L2 e

et W21
:@ Contraller Llnk [CIW-CLKZ  Transfer(retwork bo BC]

Select [CONNECt] sssssssdfssssssnssssnnnnnnnns Tt
Select Start Datalink “"‘Etart Data Link

[Transfer [Network to PC]] sssssssssssnssasssssnsansssssnsnsnssnnnnnnnnnsnnnnnnnnnnnnnnnnnnnnns®

o

(7) Send the DeviceNet network configuration on another remote PLC.

Repeat the steps from (6) and (7). After transmission, all the networks sent to the
workspace are displayed.

=zl x|

E% NewProject

ﬁ Wetwork1[DeviceMet|[#00Z2]

5 Network2_CPU Port_Serial Port(MTLink][-]
Wetwark3[ControllerLink)[(#001]
Wetwarkd[DeviceMet|[#003]

‘ol MetworkS[DeviceNet)[#004]

Project I

=

(8) Save all the configurations.

MewProject - CX-Integrator - [Network1

JJ r D Mew Ctrl+N E | = |
A 2 open... o |
JJ QF. Close o -
— u Save Ctrl+5

Select [Save As...] ssmssssssssssssssEmEas

2 3-16
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Start-Up Config. i @ Verification Al Diagnosis

System Configuration Verification (1)

Confirm that the System has the same wiring and settings as before disassembly.
= CX-Integrator verification is complete.

(1) Connect online to a PLC on a network.
The online connection information window is displayed.

BN All communications Units and ports
=8 of a connected PLC are
automatically displayed in the online

connection information window.

CPUT3] Met{0), Mode(0)
A-CPU1 3] 1]

= CPU Port [CI1M-CPU1 3] Netl-). Nodel-). Unit]-]

= DeviceNet [CI14w-DRM21] Net(2), Node{1), Urit(0)

*of Contraller Link [CI144-CLE21] Net(1), Node{1). Unitf1)

=

(2) Verify the DeviceNet network configuration.

Connect to a target DeviceNet from the workspace and verify the network Structure.
=l

L

zl x|

E\--% MewProject
" 2 T

JeviceMet] 8 -
Dped
Imsert Wetwork

< Networl
= Networl
g Networl
g Metworl

LB Metwork Delete

Transher[§E to Hetwork]
Transfer[Metwark b ]
Compare.

Transfer[PC ta Metwaork]
Transfer[Nekwark ko PC]

Select [Connect]

Conneck . T
Rename Metwork .*

Select [Compare]

Change Metwork Address

_---------W

Rename Metwork
Change Network Address

Capy(C)

Project Paste(P) Faste(Py

| Project l_

&

(3) Any error found in the configuration verification will be displayed in the verification result
dialog box.

Comparison Result

moacsic
Q) Device Type of #05 s different.

e f $
CITw-DRMZ1 )

If you find a Slave that is not on
the network, you may have
incorrect wiring in the network.

- m
It doesr't enist. mEmmm

Click [Close]
(4) After solving the error, verify the configuration again.
A message is displayed indicating
@ Ho diferences were found. verification matching and now it can
Click [OK] be confirmed that the configuration is

the same as that before disassembly.
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PLC Network

PLC
Start-Up

Start-Up

Select [Connect]

Select [Compare]

""""" N
’ i N
DeviceNet NT Link COE;;?("er CompoWay SS as\g% ' S gﬁ:ﬁ m
Start-Up Start-Up IF Start-Up yste i | Conig.
Start-Up Config. i pa Verification

System Configuration Verification (2)

(5) Verify the NT Link network.

Connect to the NT Link from the workspace and verify the network configuration.
Confirm that the same verification matching message is displayed as in step (4).
=

2l
E% NewProject E-GE MewPraject
= o Met Devicehl et)[HO02)
i a1 [Pl Pt Cerig

e . T Open

o5 Metwork Insert: Metwork

2 MNetwark
Delete

Transfer[PC ta Metwork]
Transfer[Metwark to PC]

= 3

Rename Metwark
EEEEEEEEEEEEENEEEENEENEEE

.
.
.

Rename Metwork

D W D

EEEEEEEEEEEENEEDN snmn®

(6) Verify the Controller Link network.

Connect to DeviceNet from the online connection information window and verify the
network Structure.

Confirm that the same verification matching message is displayed as in step (4).
| =

= x|

= % MewProject
o5 Network [DeviceN et)[HO02)

E--% MewProject
=5 Network][DeviceNet[#002)
CPU Port_Serial Port{NTLink][-)

Qpen
Insett Hetwork

Network
Network

Insert [Hetqark

Lelss Delete
Transfet[PE toletwork]

Controller
Link
Diagnosis

Transfer[HMetwoto PE]
Compare

Select [Connect]

Rename Metwork

Select [Compare]

* |
.® . Reemame Metwork:

Transfer[P< to Network]
Transfer[Metwark to PC]

- - @@

(7) Connect to a PLC on the Controller Link network.

Connect to a remote PLC using the same procedure as the step (5) for saving a System
configuration.

Use steps from (2) to (4) to verify the DeviceNet network.

- = Network3(ControllerLink){(#001)

[ D[]

- = Network3({ControllerLink){#001)

Hatwark3(Cantller Link]H001)

Compo3 CompoS |
A ™ Parameter
a
Display Error Lo
CJTM-CPUT3 CHG-CRL Py B J .
#a01 a 2 Status/Error of Communication Unit
J Error Log of Communication Unit
CF

Select [Change
connection to this PLC]

= % MewProject
gy Mebwork1[DeviceNet)[HO02]
- Metwork2 CPU Port_Serial Port{MTLink][-]

Select [Connect] .., .

Hetwrork3 (CantrallerLink]
Compo3 Compod CompaS
CHM-CPU CHE-CPLMSH CHE-CPLMSH
#1001 #102 #003
= | 1 |

1]

=m0
=

=

| PLC [C) LJ45H] N
= CPU Port [C1G-CPU4EH] Net(-), Nodsf-), Urit(-]
5 DeviceMet [CITW-DRM2T] Net(2). Nodel(5), Urit0]
Cantraller Link. [CITw-CLEZ1] Met(1], Mode(2], Unit[1]

nline Toolbus COR1 9600 Mone 8,7 [CIT8-CPUT 3] Net(0), Node(0)

Select [Compare]

(8) Verify the DeviceNet configuration on another remote PLC.
Use the same procedure as step (2) for Network “N4” to verify the network Structure.
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PLC Network
Start-Up

PLC
Start-Up

Right-click a Controller Link

Unit under Target PLC in === ==*f=====srssmmanrss

the online connection
information window, then
select [Connect]

3-19

: ; N
DeviceNet NT Link COE;;?("er CompoWay SS ast% ' S g%sr:feim
Start-Up Start-Up IF Start-Up yste | |y Lonlig.
Start-Up Config. i A Verification

Controller Link Diagnosis

Confirm that the Controller Link connection is correct with an upper level System.
= Diagnosis result check OK

Controller
Link
Diagnosis

(1) Connect to PLC online, then connect to Controller Link Unit through the online connection

information window.
_I = @, Online Toolbus COR1,9600,Mone, 8,1 [DJ1M EF'U‘IS]Net[D] Mode(0]

—-f; SCU F'ort [DJ'I

Conneck

Start Data Link
Start Routing Table

MT Link Tool 3
Controller Link Tool 3

=

(2) Next, select the Controller Link network tool.
x| =) @, Oriline Toolhus EDM1 SBDD None 8.1 [CITM- EPU13] Met{0], Mode(0)
1, M ade]l

Transfer[Network to PC] 3

gy SCU F‘ort [DH‘

Conneck

Start Data Link
Skart Routing Table

T Link Tool 3

Conkraller Link Tool Metwork Diagnosis

&_controller Link Network Diagnostic Tool - [NodeConfigTemp.crg]
File(E) Wiew(¥) PLC(E) Diagnose(D) Mode Status(M) Help(H)

GH Dk RE DT

Transmission Path:

Baud Rate: 2ZMbps

“Wire Type

Deolink  EENENI

Comm. Cycle Time: 4.8ms Polling Mode: Mode? Starting Node:

Results Leval
(&) Information

| Nndel Diagnostic Message |
Controller Link MNetwork is correct.

Ready [Networkt Model




On-site

Checking
Network Cﬁ”‘tPOle‘
etwor
Check

Checking CompoNet Network

Remove CompoNet communications errors and establish communications.
Check the Slave status monitor from Master Unit.
Right-click a CompoNet

Master Unit under a . .
connection target PLC (1) Connect to PLC online, then connect to a CompoNet through the online

in the online connection connection information window.

information window,
then select [Connect]

_| =}/, Oniine Toolbus COM1,13200,None3.1 [£1G-CFU42H] Net(0), Nod(0)

Stark Data Link
—

=

(2) Transfer the CompoNet network configuration to the personal computer.

-5,-7-'5 EPU F'ort [DJ1 G-CPU4ZH] Metl-). Model-]). Uritl-]

=i Contraller Link [CJ1%/-CLK 21] Net[4], Made(1 8], Urit]0)
- Compohet

= DeviceMet [CITw-DRM21]
=, Ethemet [CITW-ETNZTET

Conneck

Skart Data Link

=

(3) Select [Master only (including parameters)], then click [Transfer] button.

Transfer[Network(No network addres: x|

" MetworkMam

Metwork]

Flease select the transfered data, and press [Transfer] button
" Metwork stiucture only

£~ Metwork stiucture and Parameters for each component

& Master only (including parameters]
S ———

IF needed, transfer the network parameters for sach component as
they are not transfemed here (in the case of Contraller Link. and

SYSMALC LINK)

The Master Unit is displayed in the network configuration window.

Metwarkl(CompaMNet):MNet-)
Compoi
CJ1G-CPU4ZH
Mode (000
A {1
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On-site
Network
Check

Checking
CompoNet
Network

(4) Monitor a component.
Right-click on the
Master Unit icon and
select [Monitor] to
display the device
monitor screen. Select
[Status] tab

CHG-CPU4
Made 000

Parameter L3

Add To Metwark
Jump bo @ther Metwark

Combine bwo PLES d
Display Etror Log
The monitor window is displayed.
ETTETETTTE N )
B oo o [OMRON
etmrh St | Simm Simn | Lt S | Lren ey | Lcn Ccure |
Nl Soar
= b SOIM s L T I
J i |
—om |
A8 v 1] fowran e
(5) Click [Slave Status] tab to check the status of Slave Units.
TGN TEES— i)
E‘ [ S ——— |OITI?D|'|
o s . . ] [ e | e e |
If any unit is missing S
or communication G e
R e T
errors are detected, [ i o 12 o
= . mim miminindmds {o ] o s d
check the wiring and - F e SRR R SN EEES
i i » " » % %o [ dnde f Lt dn e £ dn-da dacda 4o £ ]
DIP switch settings of e e | B
the applicable units to EEEEEEEEEEEERREE
solve the problems. . . R - £ e
An error is detected in the i i
Slave Units indicated in red. e £ e o 1 o o
U mdmmessmisisimvasndasis
P 2 3 o o o o o P £ o 1o
B (Rt Rk s
_Owe |
AL o 1] Dovan Beim

(6) Repeat the steps (2) and (3) to confirm that the CompoNet network is functioning
properly.
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Servo/lnverter
Settings

Right-click on 3G3MV-
PDRT2 and select [Start
Special Application]

{

Select [Start with Setting
Inherited]

U d

CX-Drive starts and
Inverter property
settings are shown

Save data

DeviceNet
Connection

RS232C
Connection

Starting CX-Drive via DeviceNet

Setup Drives on DeviceNet and start CX-Drive on CX-Integrator window.
An example of 3G3MV-PDRT2 is shown below.

When opening a stored data file after starting the dedicated tool, select [Start
Only]. If [Start with Setting Inherited] is selected, new data is created.

=3;NewProject - CX-Integrator

File Edit Wiew Insert Network Component Took Windows Help

=1=l x|

NEH|SE & EB|o o

[[& 1% | g &2 |[JFo =)

e 5 &[5, KD A+ P FIERLAD |

2l x

=] % MewProject k1{DeviceNet){#012)

;ﬁ Metwark1[DeviceNetiHOZ)

=101

CI1W-DRM2L F— ,
e |
25 Monitor. ..
Reset
'.. Project Maintenance information
L2 ] xi Reqister to anather device 4
S —
Component Typa & 5 | Export »
/23 EDS[DeviceNet] ¥ 4,
13 Vendor *a, b G
18y - & (@ OMAON Coporation ¥ &, B2y Copy ChrltC
Rl = TN viceType ‘e b B easte Grl -,
AT w
8 Ty, Delete
5 Commurications Adaple® " ww fy
Change Hode sddress
[ ] .Cnangs Device Comment .
CPS EDS[DeviceNet] = Network1(D
= F

= = Q Onling Toolbus COM1,19200,None,8,1 [CI1G-CPU42H] Net(D), Node(T]
[=! ]

f

LC (| ] (0]
PU Port [CI1G-CPU42H] Net(-], Node{-), Unit(-]
Ly Contraler Link [CJT%wCLK21] Met(1), Madef8), Unitf1]
22 DeviceNet [CITW-DRM21] Net[12), Node(3), Unit(5)

" 2B Ethemet [CJTW-ETN11] Net(10]. Node(104), Unig10)

| KN
[taunch related Special Application [@ ondine’
x|
— Drive Name
|Drive1
—Drive Type ——
IIn\-'erter ﬂ ISGSMV AT - Settingz.. b .

3GIMY-A2004-PRGI2 V7
+3GIMY-PDRTZ

—Connection Type

Settings..
—Ciomments
Tvpe vour own comment in here. ;l
[ |
QF I Cancel I Help |

""*=sa... Select Settings to set
detailed Inverter specifications.

click [& I and save the data.

If more than one drive setting data is edited, drive data is saved by drive type and a total

overview is saved in a work file.
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Servo/lnverter
Settings

RS232C
Connection

DeviceNet
Connection

Connecting a Servo or Inverter to a Personal Computer Serially.

From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Drive] > [CX-Drive] to
start CX-Drive when you connect Servo or Inverter with serial connection to your computer.

Select [File] > [New] to create new data if the drive specifications are known.
If the drive is already connected, select [Driver] > [Autodetect] to detect the
model and specification of this connected drive.

Mew Drive x|

— Drive Mame
[Drivet

—Drrive Type
IInverter LI ISGSMV T j Settings..
AEIMY-A2004-PRGI2 (W7

Select [Settings] =«.., .

LY -
- v
—Connection Type =

| Direct

Settings..

—Comments

Set c_o_mm_unication Twpe your own camment in etwork | D E
Specifications river |

Slave Unit Address
oK |

Communications Timeout

4]

Make default |

@ Mumber of retrieg

[ ok | cancel | Help

=

Or, select [Driver] > [Autodetect] to detect the connected drive specification.

To execute
Autodetect, select
[Settings] and define

the search conditions [ [ Drive |Proper| Connection Description " "

]
] 4| 2]
e

Save data Click H I and save the data.
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